
RAM,  versie 1.0 

NEERSLAG AFVOERMODULE 
a (Handleiding) 

Publikaties en het publikatieoverzicht 
van de Stowa kunt u uitsluitend 
bestellen bij: 
Hageman Verpakkers BV 
Postbus 281 
2700 AC Zoetermeer 
tel. 079-361 1 188 
fax 079-3613927 
O.V.V. ISBN- of bestelnummer en 
een duideliik afleveradres. 
ISBN nr. 90.j4476.42.2 



TEN GELEIDE 

Inzicht in het neerslag-afvoerproces is onontbeerlijk in het dagelijks waterbeheer. Hierbij gaat het 
zowel om het afvoerverloop als om de uit- en afspoeling van nutriënten naar oppervlaktewater. Eén 
van de beperkingen bij het gebruik van oppervlaktewatermodellen, zoals DUFLOW, HYDRA of 
Sobek. is het ontbreken van een goede beschrijving van het neerslag-afvoerproces. 

Het project de ontwikkeling van de neerslag afvoermodule RAM is gestart met een enquéte onder 
ruim dertig waterbeheerders om de huidige toepassingen en de knelpunten in kaart te brengen. 
Hiemit bleek dat de module zoveel mogelijk diende aan te sluiten op bestaande en veel gebmikte 
neerslag-afvoemodellen. Bij de bouw van RAM is dus nadmkkelijk gestreefd naar een integratie 
van bestaande modellen. 

Bij de ontwikkeling van RAM is gesteld dat de module geschikt moet zijn voor operationeel gebmik. 
Hiervoor is gestreefd naar een zo eenvoudig mogelijk concept met een hoge mate van 
toegankelijkheid. De module diende tevens een directe koppeling tot stand te brengen tussen een 

O neerslag-afvoermodel en oppervlaktewatermodeIlen door aan te sluiten op de STOWAiUnie 
stekkerdoos Water. RAM kan derhalve zowel stand-alone als gekoppeld aan een oppervlakte- 
watermodel gebmikt worden. 

Het raamwerk van RAM onderscheidt deelprocessen voor open water-, verhard- en onverhard 
oppervlak. Per deelproces wordt, voor zover relevant, gekeken naar infiltratie van het bodemvocht, 
percolatie naar het grondwater en grondwaterafvoer naar het afwateringsstelsel. Uit- en afspoeling 
wordt beschreven door aan de verschillende deelstromen [stikstof, fosfor en ammonium) concen- 
traties toe te kennen die worden beïnvloed door additionele bronnen en reactieprocessen. 

De gebmikershandleiding zal in het engels worden uitgebracht, voor een vertaling van de begrippen 
wordt verwezen naar appendix 111 enlof de verklarende hydrologische woordenlijst van CHO-TNO. 
Het technisch ontwerp en de filosofie achter RAM zal in STOWA-rapport 96-14 uitgebreid (in het 
Sederlands) worden beschreven. 

De werkzaamheden zijn uitgevoerd door een projectteam, met als projectleiders voor de software 
ontwikkeling en coördinatie van het tesprogrdmma ir. J.J. Noort van EDS en voor de definitiefase, 
enquête onder de waterbeheerders en het technisch ontwerp ir. A.P. Salveda van Witteveen+Bos. 
Projectmedewerkers bij Witteveen+Bos waren ir. R.M. van den Boomen, drs. J.L.P.M. van dei 
Pluim, mevr. ir. P. Goessen en bij Eos ir. P. van der Berg en mevr. drs. J.  van Besouw. 
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1. Introduction 

m 4 Water authorities require a dynamic management of their extensive water systems and related infrastructure 
to provide water for industry, agriculture, domestic supply, reduction of damage due to excess of water, water 
quality control, etc. In hydraulic engineering a proper design and operation of river based structures and 
improvement works also requires consideration of the overall water system . The use of surface water models suiting 
a wide range of users and their applications has become a prerequisite for optimal design and management. 

One of the restrictions of most of the surface water models is the absence of an accurate description of the 
precipitation mnoff process. In order to improve the applicability of the surface water models, STOWA has initiated 
the development of a precipitation mnoff module (RAM). 
An adequate description of the precipitation mnoff processes is necessary for the prediction of mnoff peaks and the 
prediction of the water quality in the surface water. 

RAM is suitable for operational use. 

The current version of RAM uses DUFLOW based files to communicate with other programs. In future the 
communication with the surface water models wil1 be made usmg the standard exchange format of STOWA (SUF- 
OW). At the start of this project the defmition of SUF-OW was not completed. 

Minimal Hardware and software requirements 
IBM-PC 386 
8 Mbyte 
MS Windows 3.10 

1.2 About this manual 

In the Chapter Background (see page 2) the setup of the mathematical model is given. This chapter is divided in the 
sections: Theory, General Setup and Formula's. In the section Theory an explanation on the hydrological cycle, the 
nitrogen cycle and the Phosphor cycle is given. In the section General Setup a general description of the model is 
given, while in the section Formula's an extensive description of the governing equations is given. 

If you are new to RAM please read the chapter on Getting Started (page 51). In this chapter a step by step instruction 
of the most important features of RAM is given. In the chapters Commands (page 61) and Dialogs (page 68) you 
wil1 find a complete reference to the functions of RAM. 
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2. Background 

2.1 Theoretica1 System Description 

Insight int0 the various hydrologie processes is necessq  fora  correct description of the precipitation 
mnoff processes. The same applies to giving a correct description of mnoff and leaching, which 
requires insight int0 the mass balances. 

Preceding the Formulas, the hydrologic cycle (section 2.1.1) and the nitrogen and phosphor balances 
(section 2.1.2) are explained in this chapter. It is not intended to give an exhaustive explanation (for 
this reason the literature is referred to). But, a short description that is suficient as reference for this 
manual. 

Precipitation mnoff processes are generally described at a catchment area level. Within a catchment 
area, the relevant parameters may v q  substantially (soil w e ,  slope, land use, etc.). A detailed 
physical description of the occurring processes is, therefore, dificult to give. In the literature, the 
hydrologic cycle is generally described as a chain of processes (indicating the course of processes and 
quantifying the amounts by means of water balances). This also applies to mass balances. In this 
chapter, this point of view is the point of depamire. 

e 2.1.1 Hydrologic Cycle 
The Hydrologic Cycle is a continuous process in which water circulates from the oceans through the 
atmosphere and the rivers back to the ocean. In figure 1 the hydrologic cycle is outlined in a schematic 
cross section. The various processes are reflected in a flow chart in figure 2. 

Ocean water evaporates into the atmosphere. This water falls as precipitation partly on the land surface 
and partly on the sea surface. The precipitation that falls on the land surface, is stored temporarily on 
vegetation (interception), on objects, on the surface (depressions), in the soil (replenishment of soil 
moisture and ground water reservoir) and in open waters. The surplus precipitation, this is the 
precipitation that does not evaporate eventually, wil1 end up running off as ground water or surface 
water eventually (Van Dam, 1991). 

Before precipitation is discharged, it goes through various processes. Part of the precipitation wil1 
evaporate. The amount of precipitation that is drained dwing a time interval, cannot be put on a par 
with the difference between the precipitation and the evaporation, due to the buffer effect of the terrain, 
the subsoil and the drainage system. This buffer effect, which is the resultant of a number of reservoir 
effects of different natures and sizes, leads to time shifts between the amounts of precipitation, 
evaporation and discharge belonging together. The larger a time interval is taken and, therefore, the 
smaller the total reservoir effect is, the more the discharge wil1 approach the difference hetween 

a precipitation and evaporation. The total storage effect is, however, important to the determination of a 
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a surplus. The storage effects are less important to the total drainage during a longer period of time, hut 
1 are aimed at determining the items in the water halance (Warmerdam, 1994). 

gmund watei 

&ure I :  Hydrologic q c l e  (Warmerdam, 1994) 

jìgure 2: Hydrologic qclej7ow chart 

In the flow chart, the ground water flows (the items seepage and downward seepage) have been left out, 
in order to keep the chart surveyahle. Also the meltwater drainage (and storage in the form of snow) has 
been Ieft out of consideration. This process is not included in the precipitation runoff module. 
Futhermore, artificial supply (inlet) or extraction of water have been left out of consideration. 
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e 
The precipitation mnoff processes are described in the following sections. In this description paved and 
unpaved surfaces are distinguished between. 

2. 1. 1. 1 Paved surface 
Within paved surface a further distinction may be made in: 

Paved surface in a mral area; 
Urban area; 
Greenhouse area; 

The precipitation on paved surface in a mral area is discharged immediately by means of the surface 
(ditches), or it is discharged by means of the ground water due to infiltration outside the paved area. 

Precipitation in urban areas wil1 partly fall on paved surface (roads, buildings) and partly on unpaved 
areas (parks, gardens). The precipitation on the paved surface (ground precipitation) wil1 be drained 
through the sewer system. Part of this precipitation wil1 temporarily be stored on the street surface. The 
precipitation on unpaved surface wil1 be drained through the soil or the drainage system. 

a The way in which precipitation is discharged depends on the type of sewer system. In case of a 
combined sewer system, the precipitation is discharged in principle through sewage treahnent plants. In 
case of extreme precipitation, part of the precipitation wil1 be discharged into the surface water by 
means of ovedow.  

In case of a separated sewer system, the precipitation on paved surface wil1 be discharged into open 
waters imrnediately. Part of the precipitation wil1 be stored temporarily in the sewer system and in case 
of extreme precipitation on the paved surface. In case of an improved separated sewer system, the 
water is discharged to sewage treatment plants when little precipitation occurs (highly polluted water). 
In case of heavier precipitation, the water wil1 be discharged directly into the surface water (this water 
is considerably less polluted). 

The precipitation on greenhouses is discharged directly or through a water storage reservoir to surface 
water. 

2.1.1.2 Unpaved surface 
Within the discharge process of unpaved surface, three processes are distinguished (see figure 3): 

I.. 1. Infiltration int0 the soil rnoisture (unsaturated zone) 
2.  Percolation int0 the ground water (saturated zone) 
3. Ground water discharge into the drainage systern 

1. Infiltration int0 the soil moisture (unsaturated zone) 
Precipitation on unpaved surfaces is caught by the vegetation (interception) and the soil. ?he  amount of 
precipitation that is caught by the vegetation is difficult to determine, as is the amount of water that 
reaches the ground by flowing along die minks of trees and through foliage. This interception causes 
slowing down (and also extra evaporation) of the mnoff process, but has hardly any effect on the 
effective precipitation (Singh, 1989). In general, losses as a result of interception are small, except in 
woodlands. 
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precipitotion 

evapotronspiration 

in'erception evaporotion tronsoirotion 

percolation 

i 

absorption by roots 

j ground water discharge 

downward 
s e e p a g e  s e e p a g e  T 

figure 3: Hydrologicprocesse.7 unpuvedsurfuce 

Precipitation that reaches the surface, wil1 infiltrate and wil1 be stored in the soil moisture zone. The 
arnount of precipitation, which is stored in the soil, depends on the precipitation intensity and arnount, 
as wel1 as the infiltration capacity. The infiltration capacity describes the amount of water, which may 
infiltrate into the ground within a time unit. This depends on the nature and the state ofthe ground 
(water content, cultivation, presence of vegetation). If the precipitation intensity surpasses the 
infiltration capacity, the water stays behind on the surface level. A water film is formed on the surface, 
which fills the hollows (surface depressions). In case of prolonged precipitation, this precipitation wil1 
partly evaporate and partly flow off through trenches in the depressions (surface runoff). Surface 
runoff is characterized by short but heavy runoffldischarge peaks and represents a quick component of 
the runoff process. 

The storage in surface depressions depends to a large extent on the roughness of the terrain. In The 
Netherlands, the infiltration capacity is often high and the precipitation intensity low, so that discharge 
of the precipitation over the surface level plays a subordinate part. In case of thunderstonns temporary 
storage on the surface level rnay, indeed, arise locally. 

2. Percolation int0 the ground water (saturated zone) 
In a unpaved area, the precipitation wil1 infiltrate into the topmost soil layer. This layer, the unsaturated 

o zone, contains both water and air and is especially important to the vegetation. Moisture in this layer 
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a may evaporate (evaporation) directly or indirectly, after absorption of moisture by vegetation 
(transpiration). Transpiration is the evaporation through the stomas of plants. This evaporation includes 
exclusively soil moisture, in quantities that are required for an optimum growth of the plant. If the 
amount of soil moisture is insufficient for this, this becomes the amount the plant is able to abstract. 
The total of evaporation and transpiration is evapotranspiration. 

If the soil moisture is replenished to field capacity, the precipitation surplus wil1 percolate into the 
ground water (percolation). By precluding shallow and poorly pervious layers (loamy soil, ar intensive 
building) above the ground water surface, the infiltrated water may be drained over these layers 
(interflow). On low grounds part of the percolated water wil1 be caught by drains and discharged to the 
drainage system. 

In case of soil moistuse shortage for vegetation (a soil water content below the field capacity), the soil 
moisture is replenished by capillaty rise from the saturated zone. A condition in this case is that the 
ground water level is not too deep. In this way, part of the ground water becomes available again for 
transpiration or evaporation (Van Dam, 1985; Cultuurtechnisch Vademecum, 1988; Warmerdam, 
1994). 

3. Ground water discharge into the drainage system 

e Characteristic for ground water discharge is a quelled runoff peak by means of horizontal and radial 
resistances in the ground. In case of deep ditches (complete ditches) the horizontal resistances 
dominate. Radial resistances dominate in case of incomplete ditches and drains. Due to relatively large 
resistances in the soil, extensive slowing down occurs (Van Dam, 1985). 

Quick and slow ground water discharge processes 
The runoff of precipitation may consist of a slow and a quick component (see figure 4 and 5 ) .  The part 
of the precipitation that is drained quickly, is the quick component. It may consist of the mnoff of 
precipitation into open water, surface mnoff, interflow and m o f f  originating kom drainpipes. 

\ quick ground water discharge 

--W-- 

slow ground b w discharge 

figure 4: Quick and slow components of ground water discharge 

a 
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figure 5: Druinuge course of quick and slow ground water discharge 

The remaining effective precipitation is discharged quelled and slowed down to a relatively large 
extent, as a result of storage in the unsaturated and saturated zones (the slow component). The size of 
the unsaturated and saturated zones determines the degree of quelling and slowing down. A deep 
ground water level results in a large storage in the unsaturated zones. A large distance between the 
drainage ditches results in a large storage in the saturated zone. Also large, active pore volumes rtnd a 
small horizontal transponing power result in a large storage in the saturated zone. The larger the 
storage and slowing down in the unsaturated and saturated zones, the more the discharge is slowed 
down and the discharge peak is quelled (Warmerdam, 1994). 

Specific characteristics of runoff processes in The Netherlands 
The precipitation mnoff process in The Netherlands is generally characterized by low precipitation 
inteosities and high infiltration capacities of the soil, in combination with slight slopes of the ground 
surface. This combination of factors results in mnoff of the precipitation through the ground water for 

e the greater pan. Surface mnoff occurs in a lesser degree. 

In the Dutch situation, an intensive drainage system generally exists. The presence of open water 
creates extra storage capacity, which results in extra quelling and slowing down of the discharge 
course. The degree of quelling and slowing down depends on the pattern, the surface, the dope and the 
maintenance of water courses. In polder areas with a relatively high ground water level, the size of the 
active drainage system does not vaiy in accordance with the height o f  the ground water level. The 
thickness of the unsaturated zone is slight and the horizontal measurements of the ground water 
reservoir are constant, so that it may be expected that the total reservoir effect wil1 be subject to only 
minor variations. In sloping areas increased fluctuations may, indeed, occur. This is comparable to a 
drainage characteristic (q-h relation). In polder areas a more or less linear relation exists, whereas in 
sloping areas a bended course occurs. The hends are used by increases in the active drainage system 
when the ground water level rises. 

Generally speaking, the discharge course in an area is determined by a number of soil and terrain 
properties such as the size and the slope of the area, soil îypes, thickness and permeability of the 
aquifer, the storage capacity, land use and the namre and condition of the drainage sysrem 
(Warmerdam, 1994). 
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2.1.1.3 Water balance 
A general insight int0 the hydrologie cycle of a catchment area is obtained by sening up a water 
balance. A water balance fora  catchment area has the following form: 

Incoming terms = Outflowing terms + Change in storage in the area 

W e n  the time interval for whicb the water balance is set up amounts up to several years, the change in 
the storage of water may be neglected. Shorter time intewals are, however, required to determine the 
tunoff, because the total change in the storage of water plays an important part in the relation between 
precipitation and discharge (see section 2.1.1.2). 

The water balance for a catchment area is set up on the basis of figures 1 and 2. The incoming terms 
are the precipitation and the water inlets, the outgoing terms are the evapotranspiration and the water 
outlets. The total storage in a catchment area is built up by surface storage, open water storage and 
storage in the unsaturated zone and in the saturated zone. 

The water balance worked out fora  time interval is reflected below. In the left term the quantity of 
incoming terms are reflected; in the right term the outgoing terms and the change in the storage of 

In which 
P : precipitation in mm 
Q, : incoming flows in mm (originating from adjoining catchment areas) 

Q, : outgoing flows in mm 
K : seepage in mm 
E : evapouanspiration in mm 
W : downward seepage in mm 
A S : change in storage in the catchment basin for the reflected time interval in mm 

The above mentioned water balance is set up f o r a  catchment area. In paragraph 2.1 . l  .2 a distinction is 
made between storage in die unsaturated zone and storage in the saturated zone. The water balance 
may be split up int0 unsaturated and saturated zones to determine both storage terms. This is reflected 
in figure 6. 
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evauotransuiration infiltration 

storage surface apparent water 
table 

percolation capillary rise 

l I 
storage ground ground watei 

lateral influx water mnoff 

downward seepage 

I capillary fringe 

table 

zone 

seepage 

figure 6: Schemalic overview terms waler balance 

Water balance unsaturated zone 
The incoming terms of the unsaturated zone consist of int'ltration, capillaiy rise from the saturated 
zone and lateral inflow. The outgoing terms are evapotranspiration, interfiow and percolation to the 
saturated zone. The storage t e m  is formed by storage in the unsaturated zone (soit moisture). The 
water balance set up for a selected time interval is: 

'inf + Qcapillaiy "li = 'percolation + E + 'inter&w + Gunsaturated 

In which 
Q,d : infiltration in mm 
Q,,,il, : c a p i h y  rise in mm 

e Q i ,  : lateral inflow soil moisture in mm 
Q,,,,,, : percolation in mm 
Q,,,&W : interíiow in mm 
A S,,,,, : storage change in unsaturated zone for the reflected time interval in mm 

Water  balance saturated zone 
The ingoing t e m s  in the saturated zone consist of percolation from the unsaturated zone and lateral 
inflow. The outgoing terms consist of capillaty rise to the unsaturated zone and seepage/downward 
seepage. The storage t e m  is formed by the storage change in the ground water. 

ï h e  water balance set up for a selected time interval is: 

'percolation + ' l i  'capillaiy + K +  W+LZSsafurated 

In which: 
A S,,,,=, : storage change in saturated zone for the reflected time interval in mm 

Role of the water balance in description of precipitation runoff processes 
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O Some terms of the water balance are input in precipitation mnoff models (precipitation, water inlets, 
water outlets), other terms are calculated (evapotranspiration and ground water discharge). 

The water balance is an important tool for calibration of precipitation mnoff models. A precipitation 
mnoff model is only capable to give a correct description of the precipitation mnoff processes, if the 
water balance is described correctly. The calibration occurs by means of comparison of the effective 
precipitation with the summated effective discharge. Just one single term in the water balance is 
calibrated, rather than fitting on the total water balance. The water balance itself is used to verify the 
input values for the precipitation, water inlets and water outlets. In case of an inconsistent water 
balance, the input values wil1 be reconsidered and corrected eventually. 

2.1.2 Water Qualitv . 
In the precipitation mnoff module the water quality part is limited for the time being to the description 
of the nitrogen and phosphor balance. Hoeks et al., 1990 was used for the description of the nitrogen 
and phosphor balances. In figure 7 the N- and P-balances are reflected schematically. A division was 
made into the supply, conversion processes in ihe soil and the drainage. 

downward seepage RUPUT 
fertilisation 

biologica1 i and 
chemica1 binding 

adsorption ldesorption 

SURFACE 

OUTPUT 

figure 7:  N- and P-balances ofa ground water sysfem (Hoeh  e! al., 1990). 

a 2.1.2.1 Supply 
The supply consis& of the items fertilization, deposition and seepageldownward seepage. The N- and 
P-load of the soil in The Netherlands in 1985 is listed in table l to illustrate the size of the various 
items. 
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Table l :  N- and P-load of the ground in The Netherlands in 1985 (Kroes et al., 1990) 

I Manure I (44%) 1 (74%) 1 

Total 
Fertilization: 

(tons Nlyear) 
1.069.000 (100%) 

(87%) 

Fertilizer 
Deposition: 

Wet deposition 

Fertilization 
From the overview above, it appears that fertilization, especially the degree and the way of fertilizing, 
plays an important part in the nitrogen and phosphor balances. The fertilization is bound by mles as 
recorded in the AMvB "Gebmik Dierlijke meststoffen" (Use of manure) of 1987. Fertilization mainly 
occurs during the growth season. The nitrogen in manure is deposited for about 70% onto grasland, 
25% onto green maize plots and 5% onto other farmland. Nitrogen in artificial fertilizer is deposited 
for about 80% onto grasland and 20% onto other farmland (Kroes et al., 1990). 

(tons Plyear) 
140.508 (100%) 

(99%) 

Dry deposition 

Deposition 
The wet deposition consists of nitrogen supply through the precipitation. The "Landelijk Meetnet 
Regenkwaliteit" (National Measuring Network Rain Quality) (KNMIIRIVM) may be used to obtain 
data about the concentrations. Dry deposition consists of dust particles falling from the air onto the 
soil. The dry deposition is area-dependent. 

. . 

(43%) 
(13%) 

(5%) 
(8%) I 

Seepageldownward seepage 
The contribution of seepage and downward seepage to the total P- and N-load in The Netherlands is 
very slight on average. Locally, this may, however, be an important resource, especially in North and 
South Holland. 

(25%) 
(<l%) 

2.1.2.2 Reaction processes in the soil 
The reaction processes in the soil for nitrogen and phosphor are fundamentally different and are: 
therefore, treated separately. 

Seepageldownward seepage I <l% 

Nitrogen 
In the soil, nitrogen may exist in various forms and may be mutually converted into each other. Figure 
8 shows a schematic overview of this. 

<l% 

a 
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figure 8. Schematic overview of the nitrogen balance in rhe ground 
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INTERMEZZO I: Illustration of N-balance in the soil 

The presence of nitrogen in the soil may be subdivided into: 
Fixed nitrogen: as part of usually organic compounds, as part of plants, humus/biomass, or 
adsorbed to soil complexes. 
Solved nitrogen: especially ammonium and nitrate, also called mineral nitrogen. 'hese are present 
in the soil, because of. 
- Supply of solvable nitrogen (ree section 2.1.2.1) 

o - Mineralization of N into a fixed substance, during which ammonium is formed. 
In the soil, ammonium is converted into nitrate by so-called nitrificating bacteria: 

NH, + 2 0 , +  NO, + 2H4 + HH,O (by Nitrobacter and Nitrosomas spp)  

These bacteria have the following characteristics: 
They are aerobic; this means that they use oxygen in their metabolisms and, therefore are able to 
exist only under oxygen-rich conditions; 
They are autotrophic and use CO, as carbon source, instead of organic nitrogen compounds. This 
means that the nitrification is independent of the organic content in the soil. Nitrate is convened 
into N, by denitribing bacteria in the soil. 

Important characteristics of these bacteria are: 
Denitrification mainly occurs in an anoxic environment, this means in the absence of oxygen and 
in the presence of nitrate. Under these circumstances, nitrate instead of oxygen is used as donor of 
electrons in the metabolisrn of the bacterium; 
The bacteria are heterotrophic and require a carbon source, mainly short carbon chains. The 
fraction of organic matter in the soil and the mineralization degree of this, therefore, influences the 
denitrification. 
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0 Nitrification of the soil especially occurs in the oxygen-rich toplayer and denitrification occurs in the 
oxygen-poor bonomlayer (in anoxic layers in the saturated zone). The ground water level determines 
the availability of oxygen in the soil to a large extent. 

Above the ground water table, more oxygen is present than under it. From modeling the catchment 
areas Beerse and Reusel, it appears that the nitrate concentration may rise to 100 mg NO,-NI1 in case of 
deep ground water levels, whereas the nitrate concentration is practically zero in case of high ground 
water levels. In addition to the ground water level, the organic content of the soil has an important 
influence on the nitrogen halance. High organic content lead to high conversion velocities, which 
causes the availability of oxygen in the ground to be exhausted quicker. In these circumstances, the 
denitrification wil1 be predominant compared to the nitrification. In case of a low organic maner grade 
in the ground, this ratio is different. 

With N-halance. microbiologic processes play an important part. Generally, microbiologic conversion 
processes are influenced by temperature, soil moisture content and pH. The discharge of nitrogen from 
the soil compament  is mainly determined by the type of soil, the ground water level and the ground 
use (among others: fertilizing) 

Phosphor 

a Figure 9 shows a scheme of the phosphor balance in the soil 

FIXED SOLVED 

to iron and 
aluminium oxides 

organic P 
in plants, fertilizer 

humus and biomass 

l 
solved P 

in soil moisture 

solved P 
t in organic material 

as phosphor salts 
I I :  

RUNOFF 
figure 9: phosphor ba[ance in the ground 

INTERMEZZO 11: Illustration of P-balance in the ground 

Phosphor in the soil may be subdivided into: 

P in fixed substances 
P in biomass: The plants ahsorb phosphor for growing and incorporate it in the cel1 material of the 
plant. Also bacteria in the soil contain a fraction of phosphor; 
P adsorhed to iron and aluminium oxides. Many soil types have a significant phosphor fixation 
capacity, dependent on the smcture and Fe and Al contents. The phosphor fixation capacity 
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O differs per type of soil. The phosphor fixation capacity for clay soil is, for example, much higher 
than for sandy soil; 
The phosphor absorbs/complexes Al- and Fe-oxides in the soil. If the utilization degree of the 
phosphor fixation capacity is higher than 25%, it is phosphor saturated ground; 
P in precipitation: phosphate f o m s  precipitations in the form of for example iron hydroxide 
complexes, calcium and barium phosphate; 

P in solution 
Desorption of phosphor. P partly becomes soivable again due to desorption. The concentration is 
determined by the adsorptionldesorption equilibrium in the soil. This equilibrium may be 
described by a so called normaiized Freundlich isotherm (Kroes et al., 1990). The equilibrium 
depends on the P-content in the soil moisture, the phosphor fixation capacity and specific reaction 
velocity coefficients. 
Decomposition of organic matter. Due to rot of plant material, the fixed phosphor partiy becomes 
solvable again. 

Conclusions conversion processes nutrients 
In summary, it may be posed that microbiologie processes play a main part in the nitrogen balance in 

a the soil, whereas these are physicallchemical processes in the phosphor balance. 
Important factors in the P-balance are: 

Type of soil (phosphor fixation capacity); 
Ground use (fertilization, utilization degree phosphor fixation capacity). 

Import factors in the N-balance are: 
Ground water level; 
Organic maner content; 
Ground use (fertilization). 

2.1.2.3 Discharge 
The drainage of nutrients mainly occurs through the discharge of precipitation. In addition, nutrients 
disappear from the soil compartment due to absorption by plants. Discharge with water is usually 
subdivided in mnoff (through surface mnoff) and leaching (via ground water discharge). 

Surface runoff (runoff) 
In case of high water levels, or heavy precipitation, surface mnoff may occur. Together with the rain 
water washing off, an amount of nutrients is directly discharged into the nearby surface water. This 
phenomenon may be reflected schematically in such a way that the rain water ends up in an 

a imaginative surface reservoir, in which a complete mixing occurs (Kroes et al., 1990). In case of high 
precipitation intensities water wil1 flow off kom this place over the ground surface. Due to the 
reservoir effect, the concentration course of ninoff is relatively constant during a smal1 time scale. On a 
larger time scale, variations in the concentration course wil1 occur, dependent on factors such as 
fertilization level and absorption by crops. 

Ground water discharge (leaching) 
In section 2.1 . l  .2 a number of components are distinguished, which form the ground water discharge. 
These are interflow, drainage-discharge and slow ground water discharge. The substances flow that is 
drained with this component is leaching. In practice, leaching is mainly detemined by drainage- 
discharge. 

Other drainage 
Part of the nitrogen and phosphor is absorbed by plants and removed from the land during harvest. The 
fertilization policy in The Netheriands is aimed at an equilibrium between fertilization dose and 
nutrient absorption. In practice, however, this is most seldom the case. In most situations, surplus 
manuring occurs. 

Drainage of the soil compamnent also occurs through volatilization of ammonium. The share of 
volatilization has decreased significantly duringthe past few years, due to a change in the fertilization 

0 dose, such as injecting the fertilizer into grassland and ploughing in the fertilization on the farmland 
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within one day. Finally, nitrogen escapes from the ground in the f o m  of N,, which comes into being 
during denitrification (see section 2. l .2.2). 

In table 2 an example of an N- and P-balance of the ground of intensively fettilized grassland unto the 
ground water level is reflected. It appears from this table that the total amount of nitrogen, which is 
circulating amually, is less than 10% ofthe total storage. This amounts to less than 3% for P. During 
discharge, the point of depamire is a quick decomporition of mineral nitrogen that results in a 
reduction of 8O-9O% of the N.  

Table 2: Example o fN-  and P-balance (kgihalyear) of the soil unto the ground water level of 
intensively fertilized grassland (sand soil) (Drent 1994). 

2.2 Translation Theory int0 General Set-up 

S U P P ~ Y  
animal fertilizer 
artificial fettilizer 
harvest losses 
deposition 
mineralization 
Discharge 
volatilization 
gross plant absorption 
mineralization 
denitrification 
leaching and runofl  
Accumulation 
In rnnt m n e  (kpihai 

The design of the precipitation mnoff module is in lme with the models that are applied in the Dutch 
situation, whenever possible. In addition, the most important bottlenecks in the current use have been 
solved in this design. During the design process, a survey was held among water boards to investigate 
which bottlenecks and wishes existed. The main conclusions of this investigation are: 

Linear reservoir models are applied frequently (De Zeeuw-Hellinga, Krayenhoff Van de Leur, De 
Jager or the Nash-cascade); 
Linear reservoir models start from the effective precipitation as input. The determination of the 
effective precipitation lacks from these models (the part of the precipitation that is actually 
discharged). 

Based on these conclusions, the design includes a soil moisture reservoir for the determination of the 
effective precipitation, Iinked to a iimear reservoir model for the description of the discharge course. In 
addition, a division into types of surface is made in view of the differences in precipitation mnoff 
processes. For example, in case of a paved surface only a quick mnoff process wil1 occur, whereas an 
unpaved surface includes a slow component. By distinguishing between s p e s  of surface and between 
subprocesses, the framework of the precipitation m o f f  module is defmed. In view of the objectives, 
the emphasis of the precipitation mnoff module is at the description of the mnoff processes of unpaved 
area. Figure 10 shows the framework of the precipitation mnoff module 

185 

125 

250 

5 
55 

10.000 

RAM Precipitation Runoff Module Background l 5  

185 
400 

15 
30 

250 

80 
660 

1 O0 
40 

O 
1 O0 

20 

10 

1 

20 

0,5 
9,5 

l .O00 

80 

1 

60 

1 
39 

2.500 



Percoiation mto 
the go-ound 

water 

Ground water 
dixharge int0 
h e  drainase 

sysfem 

Leaching and 
m o f f  

&re 10: Framework of theprecipitation runoffmodule 

This chapter deals with the îranslation of the theoretica1 system description (see section 2.1) into the 
general set-up of the design (see section 2.3). It argues the choices which were made, which processes 
were included or excluded, which simplifications were made etc. This is worked out further in detail 
for each type of surface. Finally the set-up for the water quality part is worked out. Section 2.3 

0 describes the technica1 design of the precipitation mnoff module. 

Open water surface 
In open water losses are due to evaporation only. The effective precipitation is therefore simply 
calculated as precipitation minus the open water evaporation. 

The hydrograph is described by means of a single linear reservoir, describing the effect of delay due to 
storage in the open water itself. 

Paved surface 
The losses occurring in case of paved surfaces, consist of moistening and evaporation of the wet 
surface. These losses have been put equal to the open water evaporation and wil1 be minor in general. 

In the description of the hydrologie cycle paved surface has been divided into (see section 2.1.1.1 .): 
Paved surface in mral area; 
Urban area; 
Greenhouse area. 

The discharge h m  paved surface is therefore divided into two subflows: 

m 1. Paved surface discharging directly through the drainage system; 
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2 Surface discharging through a separated sewer system 

The discharge of paved surface in m a l  areas may be entered directly under subflow 1 @aved surface 
that discharges directly through the drainage system). 

The discharge of urban areas occurs through the sewer system. The way of discharge is dependent on 
the type of sewer system. In case of a mixed sewer system, the precipitation is discharged in principle 
through sewage treatment plants. In case of extreme precipitation, part of the precipitation wil1 be 
discharged into the surface water by means of overflow. 
The effluent discharge of sewage treatment plants is measured in general. In the set-up of the 
precipitation mnoff module this discharge is not included, but the point of departure is that it is entered 
directly into the flow model. This also applies to the discharge of overflows. 

In case of a separated sewer system, the precipitation on paved surface wil1 he discharged by the sewer 
system through the drainage system immediately. Pan of the precipitation wil1 be stored temporarily in 
the sewer system and on the paved surface. In general, specific models (Nationale Werkgroep 
Riolering en Waterkwaliteit, 1990 and Werkgroep Afvoerberekeningen [Workgroup discharge 
calculations], 1979) are used for the description of the discharge course. The output of these models 
may he used directly as input for the flow model. o 
In the precipitation mnoff module an improved separated sewer system is treated equal to a separated 
sewer system. An improved sewer system can therefore be simulated identically. 

The discharge from a separated sewer system is described in a sharply simplified way. The user is able 
to choose between: 

Detailed application (calculate discharge from the sewer system by a specific model); 
Simple applications (calculate discharge from the sewer system by the precipitation mnoff 
module). 

The choice between both applications wil1 depend on the desired accuracy of the calculations and the 
presence of input data. 

The discharge from greenhouse areas may be entered directly under subflow 2 (paved surface that 
discharges directly through the drainage system). With this, it is nol possible to simulate a storage 
reservoir. 

Unpaved surface 

o For the runoff processes of unpaved surface, t h e e  processes were distinguished in the precipitation 
mnoff module (see section 2.1.1.2): 
1. infiltration int0 the soil rnoisture (unsaturated zone) 
2 .  Percolation int0 the ground water (saturated zone) 
3. Ground water discharge into the drainage system. 
These processes are distinguished in the precipitation mnoff module also This set-up is reflected in 
figure 1 1. 
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process A. Infilbation into the soil rnoisture 
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process C. Ground water discharge into the drainage system 

percolation percolaiion 

4 4 
4 4 tt, 

tt, 
tt,rtt, 4 

tt, 

i 1 
quick the ground component water of slow the ground component water of wiek the ground component 1 1 4  water of slow component ai 

the ground water 
discharge discharge discharge discharge 

Option I: two parallel Nash-cascades option 2: Combination Nash-cascade - 
kayenhoff van de Leur 

& u r e  J J :  Set-up runoffprocesses unpaved surface 

1. Infiltration int0 the soil moisture (unsaturated zone) 
The infiltration int0 the soil moisture is determined simultaneously to the processes as described in 
section 2.1 . l  .2. A water balance is worked out for the precipitation in surface depressions, where the 
precipitation is either infiltrating into the soil moisture or is discharged as surface mnoff. The amount 
of precipitation that infiltrates is determined by the infiltration capacity of the soil, where the 
infiltration capacity is assumed constant in time. If the precipitation intensity surpasses the infiltration 
capacity, the remaining part of the precipitation wil1 be stored on the surface level in the surface 
depressions. If the maximum storage in the surface depressions is surpassed, the extra precipitation wil1 
mnoff over the surface as surface mnoff. 

0 2. Percolation int0 the ground water (saturated zone) 
In the description of percolation into the ground water regarding the precipitation mooff module, a 
choice has been made between a physical-mathematica1 description of the processes and a description 
based on analogy of the occurring processes, without describing these exactly (conceptual models). 
The considerations made to arrive at the choice for the precipitation mooff model are addressed below 
in further detail. 

The discharge of precipitation is determined by a number of input data (evapohanspiration and 
precipitation intensity) and by various soil and terrain properties of the catchment area (infiltration 
capacity, actual maximum and minimum moisture storage, the degree of drainage, presence of loamy 
layers, thickness of the unsaturated zone, etc.). Especially the soil and terrain properties may vary 
widely within a catchment area. These are not only dependent on the type of soil, but also on the 
ground use and the stage of growth. In addition, a numher of parameters are often unknown (such as 
infiltration capacity). Therefore, it is not simple to translate these soil properties int0 area parameters. 

Physical-mathematica1 models are based on a description of the occurring processes. Modeling these 
requires a vast amount of parameters to be entered. A large part of these parameters will, however, be 
unknown. and the translation into area values is dificult. 
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a In order to steer clear of the above-mentioned problems, conceptual models are often used for 
precipitation mnoff models. The models describe the 'hydrograph' rather then the real mnoff 
processes. An example of a conceptual model is the Wageningen model. In this model the nature of the 
various processes is described ('soil moisture' reservoir for the storage in the unsaturated zone, 
convection-diffusion equation and model Krayenboff van de Leur for the quick respective slow ground 
water mnoff). The parameters in the model do nol have a direct (measurable) physical meaning, but 
should be determined by calibration. In the model it has been anempted to limit the number of para- 
meters, so that a set (as much as possible) independent parameters comes into existente. 

It is imponant to distinguish between the various mnoff processes (surface mnoff, interflow, drainage 
and slow ground water discharge) fora  correct description of the water quality In physical- 
mathematical models this distinction is made, in conceptual models it is not made. It is remarked, 
however, that the various mnoff processes cannot be measured separately, so that with regard to this 
aspect linle significance may be anached to tbe results of a physical-mathematica1 model. 

The point of departure in the development of the precipitation runoff module is a model for operational 
use (simple set-up with a limited number of input parameters). A physical-mathematica1 model 
requires extensive knowledge of the processes and a relatively large number of parameters need to be 
determined. Therefore, a conceptual model fits the point of departure of a precipitation drainage 

a module for operational use (simple set-up) in a bener way. For this reason a conceptual model was 
chosen for the precipitation mnoff module. Hereby the point of departure is the soil moisture reservoir 
taken up in the Wageningen model. In addition, the adaptations proposed by the steering commiîtee 
and tbe external experts have been included. 

A water balance of the amount of moisture in the unsaturated zone is maintained in the soil moisture 
reservoir. The replenishment of soil moisture in the soil moisture reservoir is the calculated infikration, 
the outflow is calculated as the evaporation and the percolation to the ground water (see figure 1 I). 
Both the evaporation and the percolation depend on the actual soil moisture content. The potential 
evapotranspiration is determined based on the reference crop evapotranspiration and a crop factor. If 
crops have not been supplied with water in an optimum way, the actual evapotranspiration is smaller 
than the potential evapotranspiration. The reduction is calculated by means of a linear relation between 
the evapouanspiration and the actual soil moisture content, where the actual evapouanspiration 
decreases form the potential evapotranspiration at field capacity towards zero at the wilting point. The 
percolation int0 the ground water also depends on the actual soil moisture content. This is described by 
means of a linear relation between the percolation and the actual soil moisture, where the percolation 
decreases form the maximal percolation at saturation towards zero at field capacity 

3. Ground water discharge into the drainage system. a Finally the effective precipitation wil1 discbarge as ground water int0 the drainage system. Due to the 
resistance of the soil for water flow, a significant slowing down effect wil1 occur due to storage in the 
soil. Due to the similarity of the discharge processes with a delayed discharge due to the resistance in 
the soil, and a linear reservoir with a delayed discharge due to the resistance of the opening, this 
process is described by means of linear reservoir models. Besides the interfiow and the drainage 
discharge, a quick and slow component were distinguished in the ground water discharge in the 
theoretica1 system description (section 2.1.1.2). This distinct was made because of the difference in 
characteristics of the processes and water quality. Both the quick and slow component of the ground 
water discbarge can be defmed as a configuration of linear reservoirs. Two options are incorporated in 
the precipitation mnoff module: 
l .  Two parallel Nash-cascades; 
2. Combination of Nash-cascade and Krayenhoff van de Leur. 
In the first option, both the hydrograph of the quick and slow component are described by a number of 
linear reservoirs in series, a Nash-cascade. In the second option, the hydrograph of the quick 
component is described by means of a number of linear reservoirs parallel, Krayenboff van de Leur, 
the slow component by means of a number of linear reservoirs in series, a Nash-cascade. Using both 
options, it is possible to simulate al1 widely applied models such as De Zeeuw-Hellinga, Krayenhoff 
van de Leur, Nasb-cascade and De Jager. Varying the time constant of the reservoir and the number of 
reservoirs, the user can specify the model according to the application. For relatively quick discharge 

e processes one reservoir with a small time constant of the reservoir wil1 be sufficient, fo ra  relatively 
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e slow discharge process more reservoirs with a small time constant of the reservoir wil1 give a better 
description. 

Total run011 
In addition to the ground water mnoff a term seepage is included. This is explained further in section 
2.3.5. The total mnoff of a catchment area consists of the discharge from the three types of surface and 
the term seepage: 

Open water (Q,,, ,,,,,J; 
Paved surface (Q,,,.,); 
Unpaved surface (Q,.,.,,); 
Seepage (Q,,) 

The drainage of unpaved surface consist of the mnoff of the subflows. 
Surface mnoff (Q,,.), 
Quick component ground water discharge (Q,,,,,); . Slow component ground water discharge (Q,,,,); 

Water quality 
The composition of the discharged precipitation depends strongly on area-specific properties such as 
soil properties, degree and intensity of fertilization and land use. In practice, usually no measuring data 
per catchment area are available. An additional complication is that various subflows may be 
distinguished, which differ in flow rate and quality. Measuring data for each subflow regarding flow 
rates and composition should be available, in order to be able to draw a final picture of tbe quality. 
Possibly, it may be tried to detemine a quality-flow rate relation for the drained precipitation. 
However, this requires an extensive and lengthy measuring program. Only few data are found in the 
literature. 

An alternative for an intensive measuring campaign for surface water or subflows is the use of a model, 
in which the quality development of the drained precipitation is simulated based on a small number of 
input parameters. In the technica1 design a subflow approach has been worked out. It was tried to 
indicate a quality (development) for al1 the subflows, based on the literature. Target values are split up 
for type of land use and degree of fertilization. It was not possible to find 'target values' for al1 the 
subflows using this method. It is important to understand that this is about strongly simplified target 
values (possibly with bandwidths) with a certain inaccuracy. The user may decide whether it is possible 
to calculate with these in a sufficiently reliable way, or that a supplementary measuring campaign 
should be carried out. 

Both solutions mentioned above include disadvantages. Measuring campaigns are expensive and 
compared to the required space and time, usually provide a very limited picture only. Models are a 
(strongly) simplified reflection of the reality, so that area-specific properties or essential processes may 
be lacking. In the precipitation mnoff module a pragmatic model has been chosen as the solution. A 
big advantage of this is that water managers wil1 receive a tool to obtain a first hpression of the 
background values, also in case measuring data are lacking for the greater pari and that they wil1 be 
able to continue their model studies. Based on this tool, they wil1 be able to decide for themselves 
whether the required reliability is fulfilled for the objective of the question. A comparison with the 
quality development of the receiving surface water can be made quickly, so that serious mistakes wil1 
be noticed. Should it appear that the precipitation ~ n o f f  module differentiates to little in many cases, it 
may then be decided to cany out measuring campaigns until further notice. 

Similar to the hydrograph it is strongly recommended to calibrate the model on measured 
concentration. 

The mnoff of nutrients of paved surface, organic fixed N is a main component (NWRW, 1986). This 
term has not been included in this version of RAM. 

Remarks 
Only pari of the drainage system (primary canals) are included in the flow model. Within the m catchment area defined, also a drainage system is present (secondary and tertiary canals). These 

RAM Precipitation Runoff Module Background 21 



e watercourses are indicated in the precipitation mnoff module as 'open water surface'. The contribution 
of open water surface to the total mnoff can be neglected in most situations, because it is only a smal1 
surface. But, the discharge from open water surface directly affects the water level. 

As part of the schematisation, the user wil1 defme the catchment areas in the flow model. The 
precipitation mnoffprocesses within a catchment area are deterrnined by soil and terrain properties, 
such as slope and soil type (see section 2.1). The properties may, however, also vary strongly within 
the defmed catchment area. The point of departure in the precipitation mnoffmoduie is that only the 
types of surface (open water, paved and unpaved surface) are distinguished. Within these surfaces, the 
catchment area is regarded as being homogeneous; the soil and terrain properties may be described as 
one (weighed) average value. The spatial variety within the defined catchment area is translated by the 
model's parameters. This implicates that tbe user himherselfis responsible for splitting up a catchment 
area, i fa  diversity ofsoil and terain properties clearly exists. 

In the model the mnoff course is determined at the discharge point of a catchment area. Within a 
catchment area, however, also a drainage system is present. In case of large catchment areas, storage in 
the surface water may play a pari. This is discounted in the linear reservoir. 

The elements from tbe Wageningen model (Warmerdam, 1993) and the model BUIBAK (Harmian, 

m 1994) are incorporated in the precipitation m o f f  module. 
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2.3.1 General 
Structure of technical design description 
The technical design is worked out per type of surface. The types of surface distinguished are: 

Open water surface (section 2.3.2); 
Paved surface (section 2.3.3); 
Unpaved surface (section 2.3.4); 
Seepage (section 2.3.5). 

After that, the technical design is worked out in further detail per subprocess for each type of surface 
The subprocesses descrihed in subsections are: 

Storage in unsaturated zone (determination of effective precipitation); 
Storage in saturated zone (determination of mnoff course); 
Description of the water quality. 

Time step 
The user defines the time step in the precipitation m o f f  module, which remains constant during the 
calculation. It is recommended to use time steps similar to the time step used in input data as 
precipitation and evaporation, commonly given as 24 hour data. 

Calculation discharge from linear reservoirs 
The calculation of the mnoff takes place in two steps. First the specific discharge (unit: [mmlday]) per 
time interval is calculated. Because the inpuned precipitation intensity and reference vegetation 
evaporation applies to the precediig time interval, the specific discharge at point of time t is defied as 
the specific discharge during the time interval t-l to t .  In the second step, the specific discharge is 
converted to the momentanious discharge at the end of the time interval defined at point of time t (unit: 
[m'ls]). 

Definition precipitation and evaporation time interval 
The daily observations of the KNMI are usually used for the precipitation intensity and the reference 
vegetation evaporation. The precipitation intensity and the reference crop evaporation are defined at 
time interval t from point in time t-l to point in time t (the preceding time interval). The precipitation 
intensities provided by the KNMI are the intensities measured during the period from 08:OO hours on 

o the preceding day to 08:OO hours on the day involved. The reference crop evaporation is the 
evaporation measured during a period from 24:OO hours on the preceding day to 24:OO hours on the 
day involved (KNMI, 1995). 

Description Water Quality 
The emphasis of the water quality is at the prediction of loads for ammonium (NH4), nitrate (N03), 
and phosphor (P04), The loads are determined as the product8 of the calculated discharges and the 
concentrations. The concentrations of the nutrients can he derived from the target values, as obtained 
from the literature. The target values are stated when found in literature, specified for land use, soil 
type and type of discharge, surface mnoff, slow and quick component of the ground water discharge. 

2.3.2 Open water surface 

2.3.2.1 Determination of effective precipitation 
The effective precipitation for open water is easy to determine. The losses are equal to the open water 
evaporation according to Penmann (GHO, 1988). The effective precipitation per time interval amounts 
t0 : 
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Input I 'b,t I [mmldayl 

The crop factor for open water is equal to EO 1 ER in which E is the open water evaporation o 
according to Penmann. The factor varies somewhat but may approximately be equated with 1.25 
(Cultuurtechnisch Vademecum, 1988) 

Precipitation intensity 

Model parameters 

Output 

During dry periods the open water evaporation is larger than the precipitation intensity. In this case a 
negative effective precipitation is calculated, which equals a precipitation shortage, sirnulating 
evaporation out of surface water in the drainage system. 

2.3.2.2 Description of the Hydrograph 
The drainage of the open water surface is determined by means of one linear reservoir 
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' X ,  open- water,t 

Aupen_ water 

%pen water, t 

[mmlday] 

[mmlday] 

[hal 
[dayl 

[-l 

[m31s] 

Specific discharge open water 
surface (formula 2-a) 

Effective precipitation open water 
surface (formula 1) 

Open water surface 
Time constant reservoir open water 
surface 

Time step 

Conversion factor units 
Discharge open water surface 

qopen- water,t - i at point of time t = O a value of O is taken 

**  The conversion factor is equal to 10/(24 * 3600) 

Target values time constant 
In practice, hardly any slowing down of the discharge through open water wil1 occur. In this case a 
value of O may be taken as time constant. In relatively large catchment areas slowing down may, 
however, play a part. In this case a target value of 0.0014 a 0.002 days may be taken as time constant, 
in accordance with a time constant of paved surface (Cultuurtechnisch Vademecum, 1988). 

2.3.2.3 Description water quality 
Nitrogen 
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e The nitrogen in the precipitation on open water forms a direct emission source to the water (the time 
interval between the precipitation supply and the precipitation drainage to the water is zero). This 
means that no processes occur that are able to influence the N-content in the meantime. The nitrate and 
ammonium loads through this flow to the canals may, therefore, be described in accordance with the 
zero order relation: 

- 
' N H 4  - N,open- water,t - Qopen- water, f X ' N H ~  - N, precipitation, f ( 3 4  

I 
Model parameters I ' N H ~  - N ,  precipifafion, f 

Input 

output / ' N H ~  - N,open_ water,t 

Qopen- water, t 
[m'ls] Discharge open water surface 

(fonnula 2-b) 

Ammonium-N concentration of 
precipitation 

Nitrate concentration of 
precipitation 
Ammonium-N load of open water 
surface 

Nitrate load of open water surface 

In the drainage system al1 sorts of processes occur, such as nitrification and denitrification, which 
influence the actual ammonium and nitrate contenis in the canals. This aspect is described in the flow 
model and, therefore, is outside the scope of the precipitation mnoff model. 

In addition to nitrate and ammonium, also organic fixed nitrogen may be supplied with rain water. Rain 
water often contains a considerable amount of suspended solids. In this phase of the development, 
organic fixed nitrogen is, however, left out of consideration. Organic fixed nitrogen can be taken into 
account by the user in the concentration of the precipitation t e m .  

Phosphor 
The same assumptions as for nitrogen are applicable to phosphor. This means that the load is directly 
proportional to the flow. The phosphor load may, therefore, also be described in accordance with a 
zero order relation: 

- I I surface 

Target values 
The composition of rain water is reasonably known (Landelijk Regenwater meetnet [national rain 
water measuring network] of KNMI/RJVM). In table 3, the contenis of ammonium, nitrate and total 
phosphor in the precipitation are reflected (v.d. Meent et al., 1985). From these figures extensive 
spread of the measuring values appears. Possibly more specific measuring data are available per 
location [A factor 0.014 applies to the conversion of p molll to mg NA] 

Input 
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[ml!s] 
Qopen water, t 

Discharge open water surface 
(fomula 2-b) 



m Table 3: Overview of the average concentrations of precipitation (v.d. Meent et al, 1985) 

2.3.3 Paved surface 

2.3.3.1 Determination effective precipitation 
The losses occurring in case of paved surfaces, consist of moistening and evaporation of the wet 
surface. These losses have been put equal to the open water evaporation and wil1 be minor in general. 

Phosphor 
(mg P-totaWl) 

0.11 
0.06 
0.27 

Median 
Minimum 
Maximum 

Ammonium-N 
(mg NI0 

2.4 
1.3 
6.1 

The crop factor for open water is equal to EO / E R  in which EO is the open water evaporation 

Nitrate-N 
(mg W 

1.2 
0.90 

1.8 

Precipitation intensity 
Reference vegetation 
evaporation Makkink 

Input 

Model parameters 

Output 

according to Penmann. the factor varies somewhat but may approximately be equated with 1.25 
(Cultuurtechnisch Vademecum, 1988) 

2.3.3.2 Description of the Hydrograph 
The discharge of paved surface is divided into two suhflows: 
1. Paved surface draining directly through the dramage system; 

m 2. Surface draining through a separated sewer system. 

The mnoff of both suhflows are determined with an singular linear reservoir. A singular Iinear 
reservoir was chosen because of the relatively short reaction time. 

'b,t 

Er.t 

f0 
'N , p ved , t  

m 
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imddayl 
[mddayl 

[-l 

[mmlday] 

Vegetation factor 
Makkink for open water 
Drainable precipitation 
naved wrface 



Input t 

Ysewr,t 

Model parameters 

/ a 
Output 1 Q ~ , ~ a v e d , t  

Specific discharge separated sewer 
system (formula 6-a) 
Specific discharge paved surface 
(formula 6-b) 

Effective precipitation paved surface 
(formula 5 )  
Separated sewer surface 

Paved surface 

Time constant reservoir separated sewer 
system 
Time constant reservoir paved surface 

Time step 
Conversion factor units 

Discharge paved surface 

qsewei-,t - l and Ypaved,~ - l  at point of time t = O a value of O is taken 

.I t Paved surface that discharges through a separated sewer system 
' ** Paved surface that discharges directly in10 open water 
* * * *  The conversion rate is equal to 101(24 * 3600) 

Target value time constant 
The time constant is a measure of the velocity with which the precipitation is discharged . In case of 
paved surface a value of 0.0014 A 0.002 days is generally taken (Cultuurtechnisch Vademecum, 1988). 
If measured values are available, it is more accurate to derive the time constant from the tail course of 
the measured discharges. This concerns both the time constant for the reservoir for the separated sewer 
system as for the paved surface. 

2.3.3.3 Description of water quality 
Nitrogen 
The discharge of paved surface originates from roofs and roads and is discharged through drain pipes 
or through a(n) (improved) separated sewer system into the drainage system. It is also applicable to this 
drainage that hardly any processes occur that influence the N-concentrations. The nitrogen load may, 
therefore, also be described in accordance with a zero order relation. However, it is indeed applicable 
to this drainage that organic fixed nitrogen may be a factor of importante. Therefore, an equation has 
heen included for this. The discharge is described by the following fortnulas: 
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c) 

Ammonium-N concentration mnoff 
paved surface 
Nitrate concentration mnoff paved 
surface 
Organic nitrogen in runoff paved 
surface 
Ammonium load of paved surface 

Nitrate load of paved surface 

Organic nitrogen in mnoff paved 
surface 

l a 

In the first version of the precipitation mnoff module, the term organic fixed nitrogen has nol been 
included. 

Phosphor 
Also for phosphor the concentration of the discharge may he taken as a constant. The timeframe 
between precipitation and discharge is short, so that the influence of reaction processes is zero. 

Discharge paved surface (formula 6- 1 Input 

Model parameters 

Output 

Target values 
The quality of the discharge from paved surface is deterrnined to a large degree by the function of the 
area. The Nationale Werkgroep Riolering en Waterkwaliteit ( l  986) distinguishes the following main 
functions: 

e Residential areas; 
Commercial areas (shops, offices, catering companies, secondary housing function); 
Roads; 
Industrial areas. 

Input 

Model parameters 

Output 

The quality of the discharged precipitation also depends on the type of sewer system. The water quality 
in case of an improved separated sewer system wil1 be different from a separated sewer system. If the 
lower discharge amounts of improved separated sewer system are taken into account, it is acceptable to 
use the same target values for the concentrations. 

Qpaved,i 

' N H ~ -  N , p m e d , t  

' ~ 0 3 -  N , p w e d , i  

'erg - N,paved,i 

' N H ~  - N,paved,r 

' ~ 0 3 -  N , p w e d , t  

'erg - N, pmed, t  

The concentration of pollution in the discharge from paved surface fluctuates strongly. In table 4 the 
bandwidth between which the concentrations v q  are indicated. 

[m3is] 

[mg W 

[mg NU 

[mg Ni11 

k NISI 

[g N/sl 

[g NISI 

Qpaved, i 

'P - total, paved,t 

' P  - total,paved,t 
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[m'ls] 

[mg PI11 

[g pis] 

Discharge paved surface (formula 6- 

c) 

Phosphor concentration mnoff paved 
surface 

Phosphor load of paved surface 



Table 4: Overview target value pollution concentrations mnoff paved surface (Nationale 
Werkgroep Rioleringen en Waterkwaliteit, 1986) 

I Residential I Commercial [ Roads I Industrial 

2.3.4 Unpaved surface 
For the mnoff of unpaved surface, three processes were distinguished: 
1 .  Infiltration into the soil moisture (unsaturated zone) 
2. Percolation into the ground water (saturated zone) 
3. Ground water discharge into the drainage system 
These processes are distinguished in the precipitation ninoff module also. This set-up is reflected in 
figure 10. 

Ammonium (mg Nfl ) 
Nitrate (mg NA) 
Total Phosphate (mg PA) 
N-Kjeldahl (mg NA) 

2.3.4.1 Infiltration into the soil moisture (unsaturated zone) 

First, the infiltration into the unsaturated zone is determined. In addition, the storage in the surface 
depressions and possibly occurring surface mnoff are determined. These aspects are addressed below 
point by point: 

Infiltration; 
Storage in surface depressions 
Surface ninoff 

The amount of precipitation that infiltrates is determined by the infiltration capacity of the soil. If the 
precipitation intensity surpasses the infiltration capacity, the remaining part of the precipitation wil1 be 
stored on the surface level in the surface depressions. If the maximum storage in the surface depression 
is surpassed, the extra precipitation wil1 mnoff over the surface (surface ninoff). 

Areas 
0.15-2.5 

0.1-0.7 
0.22-1.5 

1.5-3.6 

Infiltration 
In the design the point of departure is a constant infiltration capacity. This is further explained at the 
target values for the infiltration capacity. The infiltration intensity is calculated for the time interval 
from point of timet- 1 to t .  The precipitation intensity during the time interval is added to the storage 
existing in surface depressions at the start of the time interval (formula 9-a). When tbe precipitation 
intensity and the storage in the surface depressions surpasses the infiltration capacity, the infiltration 
capacity is set equal to the infiltration capacity (formula 9-b). 

A specific situation occurs when the unsaturated zone approaches saturation. The maximum 
percolation out of the soil moisture reservoir instead of the infiltration capacity becomes critical for this 
situation (formula 9-c, see also section 2.3.4.2). 

Areas 
0.03 

0.2-0.5 
0.1-0.6 
0.7-1.1 
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0.13-2.5 
0.28-1.4 

0.05-0.48 
0.68-5.1 

Areas 
l .2-6.9 

5 

1.2-200 



Input 

Model Parameters 

Output 

I M d a y I  Precipitation intensity 

[mm] Storage in surface depressions (forrnula 
10) 

i w d a y l  I ~nftltration intensity (formula 9) 

[mm] Actual moisture storage (formula 14) 

Immldayl Infikration capacity 

[dayl Time step 
[mm] Percolation to the saturated zone at 

pF=O 
[mm] Moisture storage if pF=O 

[mm/dayl Infikration intensity 

For BI - , at point of time t = O, a value of O is taken, equalling a situation without storage in surface 

depressions. 
**  For I t  -, at point oftime -0, a value of O is taken, equalling a situation without infiltration. 
*** For Q1 - at point of time -0, a value of O is taken, equalling a situation with field capacity pF=2 (to 

be determined fom rhe Staring Series). 

Storage in the surface depressions 
~ h e n t h e  precipitation intensity surpasses the infiltration intensity, the water stays behind on the 
surface level and is stored in surface depressions. This storage in surface depressions depends strongly 
on the roughness of the ground. The storage at point of time t is determined with a water balance for the 
storage in surface depressions. For this purpose the precipitation intensity minus the infiltration 
intensity during time interval t-l to t is added to the storage present in the surface depressions at the 
start of the time interval (point of time t-I). No water remains in the surface depressions when this 
volume is smaller than the infiltration capacity (formula 10-a). When this volume surpasses the 
infiltration capacity, water is stored in the surface depressions (formula 10-b). Surface mnoff wil1 occur 
when the amount in the surface depressions surpasses the maximum storage (formula 10-c). 

if P +- B , _ ]  > I- and (10-b) - 1 b,! AI 

if (Pb,! - I t W + B , _ l  B,, 

B l - l > I  and P +-- 
b,! A m (10-c) 

( P  b,! - I t ) A t + B * - l  > B m  
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I I1 I [mmldayl I Infikration intensity (formula 9)  l 
Input I 'b,{ I [mdday l  

Precipitation intensity 

I [mm] Maximum storage in surface 
denressions i 

* [mm] 
- l 

Model Parameters lmlY [mmlday] 

Storage in surface depressions 
(formula 10) 
Infiltration capacily 

For B1 - at point of time t = O, a value of O is taken. equalling a situation without storage in surface 

depressions 

AI / Idayl 

Surface runnff 
The amount of precipitation that nins off as surface mnoff, depends on the infilh.ation capacily of the 
soil, the precipitation intensity and the storage in surface depressions. When the amount of storage in 
surface depressions surpasses the maximum storage, surface runoff occurs. 

Time step 

Input 

Model Parameters 

Output I B, I [mmlday] I Storage in surface depressions 

[mmlday] 

Imml 

[mmlday] 

[mm1 

Precipitation intensity 

Infiltration intensity (formula 9) 

Storage in surface depressions (formula 
10) 
Infiltration capacity 

Maximum storage in surface depressions 

Time step 
Effective precipitation surface mnoff 
unpaved surface 

For BI _ at point of time t = O, a value of O is taken, equalling a situation without storage in surface 

depressions 

In this section the effective precipitation for the surface ninoff is described. The hydrograph is Further 
described in section 2.3.4.3 

The evaporation from the surface depressions has nol been included. The evaporation is indeed 
included as evapotranspiration from the unsaturated zone in the soil moisture reservoir. By neglecting 
the evaporation from surface depressions a slight error is introduced in general. 

Target  Values infiltration capacity 
The velocitv of infi ltration d e ~ e n d s  on the intensily and the duration of the precipitation, type of soil, . . 
land use, and soil moisture content at the start of the shower. During a shower with a constant intensity, 
the infiltration velocity decreases exponentially from a maximum value f, at the start of the shower to 
an constant value f,. This value is reached when the soil reaches the field capacity (see figure 12). 
Various formulas have been developed to determine the infiltration capacity of a type of soil. 
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figure I 2  Infiltralion velocify 

In the precipitation mnoff module the precipitation mnoff process is described at a catchment area 

a level. An average value for the infiltration intensity in the catchment area wil1 have to be entered. The 
infiltration intensity will, however, v a q  widely per iocation, due to variation in vegetation and type of 
soil. In addition, the infiltration intensity wil1 vary in time and wil1 decrease to a constant value when 
reaching the field capacity (PF = 2). Generally, the constant infiltration intensity as outlined in figure 
12 wil1 be reached within one day. This value is named as the infiltration capacity. 

No infiltration formulas have been included in the precipitation mnoff module. The user may enter an 
infiltration capacity for the catchment area involved, which is constant in time. The error introduced by 
this wil1 be minor in case of time steps of one day or larger. Table 5 gives an overview of the values 
found in the literature. 

Table 5: Target values infiltration capacity 

Texture* 
Sand (Wyseure and Feyen, 1982) 
Finer texture 
Very fineldisturbing layers 
Impe~iouslclay with swelling 

* The texture classes are copied from the literature. 
** The infiltration capacity is expressed in [mmlday] instead of [mnwñour] 

Iníiltration capacity** after much rain 
7.6-1 l .4 mnwñour 
3.8-7.6 mmihour 
1.3-3.8 mmihour 
0.0-1.3 mmihour 

0 

Target values maximum storage in surface depressions 
The maximum storage in surface depressions depends on the roughness of the terrain and the degree of 
vegetation. Representative target values for the maximum storage in surface depression are difficult to 
give, in view of the wide variety of these parameters within areas. Based on the roughness and 
vegetation on the ground, an estimate wil1 have to be made for this value. In general, the choice of this 
value wil1 hardly influence the model results, because a situation in which the maximum storage in 
surface depressions occurs, hardly takes place in the Dutch situation. 

2.3.4.2 Percolation into the ground water (saturated zone) 
The percolation int0 the ground water is described by means of a soil moisture reservoir. A water 

e balance of the amount of moisture in the unsaturated zone is maintained in the soil moisture reservoir. 

Saturated clay soil (BUIBAK, 1994) 
Loamy and peaty soil 
Very pewious sand 
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approximately 4 mm/hour 
8 mmlhour 
approximately 12 mnwñour 



ï ñ e  replenishment of soil moisture in the unsaturated zone or the inflow of the soil moisture reservoir 
is the infiltration calculated by the model. The outflows are the evapotranspiration and the effective 
precipitation (the precipitation that runs off through drains or ground water). The principle of the soil 
moisture reservoir is reflected in figure 11 

In the precipitation mnoff module, capillary rise from the ground water to the unsaturated zone has not 
been included. Furthennore, it has been assumed that the infiltration immediately results in percolation 
The occurring slowing down is ignored. This results in errors in the calculated evapotranspiration and 
the percolation. 

Evapotranspiration relation 
The potential evapotranspiration is determined based on the reference crop evapotranspiration and a 
crop factor. ï ñ e  crop factor is a measure for the transpiration of the crop and depends on the type of 
crop and the growth stage (function of time). If the crop has not been supplied with water in an 
optimum way, the actual evapotranspiration is smaller than the potential evapotranspiration. A simple 
relation between the actual evapotranspiration and the actual moisture storage is included 
(evapotranspiration relation). It has been assumed that in case of water contents lager  than those in 
case of field capacity, the actual evapotranspiration is equal to the potential evapotranspiration. 
Between the moisture storage at field capacity and the wilting point, the actual evapotranspiration 
decreases linearly from the potential evapotranspiration at field capacity to zero at the wilting point. 1t 
has been assumed that no moisture is available to the vegetation at the wilting point. 

Output I 

[mmiday] 

[mm1 

[mm1 

[-l 
[mm/da?l 

Actual moisture storage 
(formula 14) 
Reference crop evapotranspiration Makkink 

Moisture storage if pF=2 

Moisture storage if pF=4.2 

Crop factor Makkink 

Actual evapotranspiration 

Far a, -, at point of time t = O, a value of O is taken, equalling a situation with field capacity pF=2 (to 
. . 

be detemined Erom the Staring series) 

Percolation relation 
The percolation to the ground water depends on the water content in tbe unsaturated zone. In the 
precipitation mnoff module, a simple relation between the percolation and the actual moisture storage 
(percolation relation) has been included. lt has been assumed that in case of saturation, the percolation 
is equal to the maximum percolation. Between the moisture storage saturation and at field capacity, the 
percolation decreases linearly from the maximum percolation at saturation to zero at field capacity. It 
has been assumed that no moisture is available for percolation at the wilting point. 
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' pex , t  = O  

Input 

Model Parameters 

Output 

Actual moisture storage 
(formula 14) 
Infiltration intensity (formula 9) 

Moisture storage if pF=O 

Moisture storage if pF=2 I 
Moisture storage if pF=4.2 I 
Percolation to the saturated zone that occurs I 
be[uucn pF í. arid pk-? ~rnaxirnum~ 
Pcrc~lation nio the 5aturuir.d Lone 

I For -, at point of time t = O, a value of O is taken, equalling a situation with field capacity pF=2 (to 

be detennined from the Staring series) 

Water balance soil moisture reservoir 
In the water balance, both the evaporation and the percolation depend on the actual soil moisture 
content. The change in the soil moisture content is described with the differential equation: 

The equation is solved explicitly. At point of time t-l the condition of the soil moisture reservoir is 
expressed in the moisture storage O,+, . Based on the actual moisture storage at point of time 1-1, the 
evapotranspiration and percolation are calculated for the time interval from point of time t-l tot .  Based 
on the calculated evapotranspiration and percolation, the actual moisture storage at point of time t is 

Input l O t - l  
* 

Model Parameters I At 
Output I @, 

[mmlday] 

Actual moisture storage (formula 14) 

Infiltration intensity (forrnula 9) 

Percolation int0 the saturated zone 
(formula 13) 
Actual evapotranspiration (formula 12) 

Time step 
Actual moisture storage 

For O t  - at point of time t = O, a value of O is taken, equalling a situation with field capacity pF=2 (to 

be detennined from the Staring series) 

Disadvantage of an explicit solution is the risk of instable calculations, occurring with large time steps 
or a relatively small content of the soil moisture reservoir. In case of instable calculation, the user 
should define smaller time steps. a 
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The moisture storage in the soil moisture reservoir varies beween the minimal moisture storage at 
wilting point and the maximal moisture storage at saturation. For moisture storage values smaller than 
at wilting point, no evaporation occurs (formula 12-c), for values larger than the at saturation the 
percolation is set equal to the infiltration capacity (formula 13-a). 

Target  values crop factor Makkink 
The crop factor depends on the type of overgrowth and the growth stage. In appendix I an overview is 
given of the crop factors for various crop types. The crop factor for a catchment area is determined as 
the mem crop factor per percentage of the surface for the different crops in the catchment area. 

Target values moisture storage 
In the formulas 13 and 14, the moisture storage at field capacity (pF=2) and at the wilting point 
(pF=4.2) need to be entered. The moisture storage in the unsaturated zone is derived from the soil 
moisture content and the location of the ground water level compared to the surface level. It is 
remarked that the moisture storage depends on the location of the ground water level. In polder areas 
slight fluctuations in the ground water level occur in general. In sandy soils more fluctuations occur, so 
that also the moisture storage wil1 vary. 

In the Staring series, the soil moisture characteristics for various types of soils are determined. This is a 

a relation between the pF value (logarithm of the negative pressure head) and the soil moisture content. 
Based on the Staring series, the water content at field capacity and at the wilting point may he 
detemlined for the various types of soils. In appendix I1 a summary of the Staring series is given. 

Therefore, the following method may be used to determine the moisture storage: 
The length between the average surface level and the average ground water level or water level in 
the drainage system is estimated. This length is assumed being constant during the simulation 
period (for example 0.8 m); 
The soil moisture content is determined for the dominating type of soil at saturation level (pF=O), 
at field capacity level (pF=2) and at the wilting point (pF=4.2). These values are recorded in the 
Staring series (see appendix 11) for the most common types of soil. As an example, the values for 
'loamy-poor, ves. h e  to moderately fuie sand' are 3 7 1  volume percent (pF=O), 20.1 volume 
percent (pF=2) and 3 volume percent (pF=4.2). 
n i e  moisture storage is determined as the product of the length of the unsaturated zone and the 
volume fraction. In the example above this would be: 

O p F = O  = 0.371 x 0.8m = 296.8mm 

target value maximum percolation 
The maximum percolation is the percolation at saturation. Mostly the infiltration capacity is taken as 
target value for the maximal percolation. Table 5 gives an overview of the target values for the 
infiltration capacity. 
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e 
2.3.4.3 Ground water discharge into the drainage system 
The discharge from unpaved surface is built up by various mnoff processes. The in tedow and the 
drainage have not been described separately, but jointly form the quick ground water mnoff. Within 
the design the following aspects are distinguished: 

Surface mnoff; 
Quick component of the ground water discharge; - Slow component of ground water discharge. 

Surface runoff 
This discharge is described with one linear reservoir, equal to the description for discharge of open 
water (the discharge of the water across the surface level to open water takes place relatively quickly) 

Input e 

qxw,t - l 

Model Parameters 

j a 
Output j psur,t 

Specific surface mnoff unpaved ~urface 
(formula 15-a 
Effective precipitation surface mnoff 
unpaved surface (formula 1 l )  
Unpaved surface 

Time constant reservoir surface mnoff 
unpaved surface 
Time step 
Conversion factor units 

Surface mnoff unpaved surface 

Qsur,r - I at point of time t = O, a value of O is taken 

I *  The conversion factor is equal to 101(24 * 3600) 

Target value time constant 
The time constant is a measure for the velocity with which the precipitation is discharged. The surface 
mnoff wil1 take place very quickly. As target value a value of 0.0014 á 0.002 days may be taken, 
equalling the time constant of paved surface (Cultuurtechnisch Vademecum, 1988). 

Quick and slow component of the ground water discharge 
During the discharge through the saturated zone, a significant slowing down effect occurs because of 
resistances in the soil. This process is described by a configuration of linear reservoirs. The quick and 
slow component of the ground water discharge are described by separate linear reservoirs, of wbich 
two possibilities are taken up. 

(a) Two parallel Nash-cascades; 
(b) Combination of Nash-cascades and Krayenhoff van de Leur 

ad (a) two parallel Nash-cascades 
In this option, the discharge is divided into a quick and a slow component ground water mnoff by 
means of a distribution code. The percolation calculated wil1 partly mnoff through a slow component 
(PPDerc ) and partly through a quick component ([l-PIPperc ). The hydrographs of both the quick 

and slow ground water discharge are described by a series of linear reservoirs (see figure 1 I). By 
entering the time constant and the number of reservoirs, the user may enter the properties of the 
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a discharge process. In the precipitation mnoffmodule, a default value of one has been taken for the 
number of reservoirs. 

The quick and slow ground water discharges are descnbed by the following formulas: 

For the 1" reservoir: 

For i is the 2"* unto and including the m" reservoir: 

- 
qquick,i, t  - qquick,r,l - I 

kq 
e + q q u i c k , i - l , t  ( l - e  k y  

For the 1" reservoir: m 

For i is the 2"' upto and including the n' reservoir: 

-At -Al - 

nput 

víodel Parameters 

Percolation into the saturated zone 
(formula 13) 
Specific slow component ground water 
discharge unpaved surface (formula 16) 
Specific quick component ground water 
discharge unpaved surface (formula 16) 
Unpaved surface 

Distribution code quick and slow 
components ground water discharge 
Time constant reservoir slow component 
ground water discharge 
Time constant reservoir quick 
component ground water discharge 
Number of reservoirs quick component 
ground water discharge 
Number of reservoirs slow component 
ground water discharge 
Time step 
Conversion factor units 
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qslow,i,t - l qquick,i,r - l at point of time t = O, a value of O is taken for al1 reservoirs 

i=l -nandi=l-m 
* e  The conversion rate is equal to 10/(24 ' 3600) 

I 

ad (b) combination Nash-cascade and Krayenhoffvan d e  Leur  
In this option the discharge is also divided into a quick and a slow component ground water discharge, 
by means of a distribution code. The hydrograph ofthe quick ground water discharge is described in 
this option by a number of parallel linear reservoirs (Krayenhoff van de Leur). The slow ground water 
mnoff is described by a series of linear reservoirs (see figure l l). A default value of one has been taken 
for the number of reservoirs in a series. 

The quick and slow components of the ground water discharge is described by the following formulas: 

Drainage slow component ground water 
discharze 

output 1 Qs1ow.r 

Qquick,r 

o For i is the 1" unto and including the d' reservoir: 

[m3/s] 

For the I" reservoir: 

[m3/s] 

-AI - -AI 

- ks  k 
qslow,l,t - qslow,l,t - I e +PPperc,t ( i -e  S ) 

Drainage quick component ground water 
discharge. 

o For i is the 2"' upto and including the nh reservoir: 

-AI - -AI - 

k~ k 
9slow,i,t = qsIow,i,r - l e +qslow,i- ],I ( l -e  S ) (1  7-c) 

Percolation into the saturated zone ( f o n u l a  
13) 
Specific slow component ground water 
discharge unpaved surface (formula 17) 
Specific quick component ground water 
discharge unpaved surface ( f o n u l a  17) 
Unpaved surface 
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Model Parameters r 
Output k- 

Distribution code quick and slow 
components ground water discharge 
Time constant reservoir slow component 
ground water discharge 
Time constant reservoir quick component 
ground water discharge 
Numher of reservoirs quick component 
ground water discharge 
Number of reservoirs slow component 
ground water discharge 
Time step 
Conversion factor units 

Discharge slow component ground water 
discharge 
Discharge quick component ground water 
discharge. 

q d o w , i , f  - l "d qyuick, i , f  - l at point oftime t = O, a value of O i s  taken for al1 reservoirs 

i= l -nand i= l -m 
e *  The Krayenhoff van de Leur model describes an infinite number of reservoirs. This is discreticised to a 

finite number of reservoirs. Each next reservoir ernpties quicker and processes a smaller part of the 
precipitation The target vaiue for the number of reservoirs is 5 reservoirs. 

*** The conversion factor is equal to 101(24 * 3600) 

Target values time constant 
The target values for the time constant of linear reservoirs are derived from measured bydrographs. 
The target values for the Krayenhoff van de Leur model are given in table 6 .  Since catchment areas are 
mostly not homogeneous, the time constant can be calculated as the weight m e m  time constant per 
percentage of the surface. 

The target values as presented in table 6 can not be used at once. Tbe precipitation mnoff module is 
extended compared 10 the Krayenhoff van de Leur model. It distinguishes paved and unpaved surface, 
so the time constant is specified for each type of surface, where the time constant for the unpaved 
surface only describes the discharge processes for unpaved surface. The time constant in the 
Krayenhoff van de Leur modei only describes the full surface (paved and unpaved surface). In 
addition, the precipitation mnoff model descnbes part of the slowing down in the soil moisture 
reservoir. This haz consequences for the time constant to be used for the linear reservoirs. The target 

e values can therefore be used as start values, but calibration of the values with measured discharges 
remains essential. 

An other way to derive the time constant is from measured hydrographs. This is the most direct and 
accurate way to estimate the time constant. In addition, die time constant of hoth the quick and slow 
component of the ground water discharge can be estimated separately. The quick component is 
estimated from the hydrograph of discharge peaks, whereas the slow component is estimated from the 
hydrograph during low discharges. 
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Table 6: Target values for the Krayenhoff van de Leur model 

Drainage type 

Discharge of 1000-4000 m2 paved surface 
Surface mnoff on strongly sloping ground 
Suriace mnoff, mnoff of grounds with impervious layers at a very shallow 
depth 
Runoff of well-drained farmland 
Badly drained grassland with overgrown ditches (swamp mnoff) 
Discharge of seepage from high, very pervious grounds (Veluwe, Zuid- 
Limburg) 

Target values configuration linear reservoirs 
The precipitation mnoff module distinguishes a quick and slow component of the ground water 
discharge. The user defines the number of reservoirs and the distribution code related to the 
application. 

For rather simple applications, it is not particularly necessary to distinguish a quick and slow 
component of the ground water discharge. The ground water discharge is described by a single 
component with a single linear reservoir and a value for the distribution factor of 0 or I 

For more detailed applications, however, it is recommended to distinguish a quick and slow component 
of the ground water discharge. It is not possible to give target values for the distribution factor. This 
factor should therefore be calibrated on measured hydrographs simultaneously to the time constants 
(see target values time constant). 

In the Nash-cascade, the number of reservoirs in series must be entered. The default is one reservoir. In 
case of large catchment areas, extra travel time may be created by entering several reservoirs. 

The model Krayenhoff van de Leur theoretically describes an infuiite number of reservoirs. In the 
precipitation mnoff module, the model is discreticised int0 a fuiite number of reservoirs, in which each 
next reservoir empties quicker but processes a smaller part of the precipitation. In case of a number of 
reservoirs of 5, the error introduced is negligible. 

2.3.4.4 Description water quality 
The description of the water quality is based on the discharge processes distinguished for the 
determination of the hydrograph, surface mnoff, quick and slow component of discharge (see section 
2.3.4.2). 

1. Surface runoff 
Nitrogen 
The surface mnoff is formed by precipitation that runs off directly across the surface level. In this case, 
reaction processes occur to a lesser degree. Therefore, the load is described by an a zero order relation. 
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Nitrate concentration surface mnoff / c ~ ~ 3 - n . i u r , t  unnaved surface 

Surface mnoff unpaved surface (formula 
15-b) 
Ammonium-N concentration surface 
mnoff unpaved surface 

Input 

Model Parameters 

1 [E NISI Nitrate load surface mnoff unpaved 1 S ~ ~ 3 - ~ . i u r . t  surface 

Output 

Qsur,, 

' N H ~  - N,sur,t 

In the first version ofthe precipitation mnoff module the term organically fixed nitrogen has nol been 
included. 

[m3is] 

imgNll1 

'erg - N ,sur, t 

' N H ~  N,sur,t 

'mg- N,sur,t 

Phosphor 
The phosphor load is described by a zero order equation just as nitrogen. 

[mg N U  

[g NISI 

k NISI 

Target values 
Only few target values are known for the concentrations of surface mnoff. The concentration depends 
very much on the time scale and the ground use. Duriig a longer period, this concentration wil1 
approach that of the precipitation. On a small time scale, ground use and fertilisation level are 
determining factors. The target values as obtained form the literatue are listed in table 7.  

Organic nitrogen concentration surface 
mnoff unpaved surface 
Ammonium load surface mnoff unpaved 
surface 

Organic nitrogen load surface mnoff 
unpaved surface 

2. Quick component of the ground water discharge 
The quick ground water discharge consists of precipitation, which is discharged through drain pipes, 
after infiltration into the ground (see figure 4). Contrary to the slow ground water discharge, this 
precipitation is buffered to a less degree, before it is discharged. The concentration nutrients is, 
therefore, often higher and there is more fluctuation. 

Surface mnoff unpaved surface (formula 15- 
b) 
Phosphor concentration surface mnoff 
unpaved surface 
Phosphor load surface mnoff unpaved 
surface 

In case of leaching of nutrient loads, it is relevant to distinguish between various types of ground use, 
especially between fertilised and non-fenilised surfaces. In case of non-fertilised surfaces the nutrient 
concentrate profile is much flaner in the vertical direction than in case of fertilised surfaces. 

[m31s] 

[mg Pil] 

[g p/sl 

Input 

Model Parameters 

Output 

Nitrogen 
A factor of influence is the flow rate of effective precipitation. The key question is whether the 
precipitation can lead to such a thinning that in case of much precipitation, the concentration decreases 
substantially. In the intermezzo below, a calculation model is worked out, in which is concluded that 
the influence of the precipitation flow rate has little effect on the N-concentration. At an annual or 
seasonal level, variances may occur, depending on the fertilisation, etc. However, it is impossible to 
link these to the amount of precipitation. 

Qsur,t 

' P -  totai,sur,t 

' P -  totol,sur,i 

INTERMEZZO 111: Calculation examples 
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At lm surface level is a drainage system that discharges diiectly int0 the drainage system under 
consideration. The average nitrate concentration in the ground moisture is expected to be higher thm in 
the discharged precipitation. Certainly in case of fertilised surfaces with higher concentration in the 
toplayer, this is the case. In the examples below, a uniform concentration distribution is the point of 
depamire. In this assumption, the leaching of nutrients is equal to the ratio between the amounts of soil 
moisture and effective precipitation. Runoff of precipitation occurs if the field capacity is reached. 
Two examples have been worked out, one for sand with a slight field capacity m d  one for clay with a 
large field capacity. Drainage takes place at a depth of lm and the annual effective precipitation is 
assumed to be 300 mmly. As maximum supply of precipitation the infiltration capacity of the type of 
soil is taken. The precipitation is, however, seldom so heavy that this capacity is reached. 

Overview of the degree of thiming of the soil moisture 

The thinning on a hourly basis is relatively slight. The concentration course as a result of thinning is, 
therefore, negligibly small. 

Average annual thinning 
of the ground water 

moisture 

Field capacity 
(m3 soil 

moisture/m3) 

Sand 
Clay 

In case of fertilised surfaces, an increased concentration in the drained ground water may occur, due to 
migration of nihate-rich water from the fertilised toplayer of the soil. The interface between nitrate-rich 
and nitrate-poor ground water is moving in a vertical direction, until it arrives at the drain pipes. 
NITSOL calculations (Hopstaken et al., 1987) for sandy soils indicate that nitrate concentrations at a 
depth of 50-75 cm are relatively constant, in case of a step size of decades. Variances in concentration 
occur mainly in the topmost 25 cm of the soil. In case of smaller step sizes, for example of hours, the 
concentration course may be very different. As far as known, on-line measuring has never heen carried 
out regarding surface mnoff, for example after a fertilisation period. As a result of lack of information, 
it is proposed to keep the ammonium and nitrate concentrations constant. This however reduces the 
accurateness of the model results in case of smaller step sizes. 

The relation between the ground water level and the denitrification has been investigated (Steen- 
voorden, 1983, Bouwmans et al., 1989). The ground water level is classified in ground water steps, 
which are determined by the average highest and average lowest ground water level (GHG or GLG). 
The denitrification factor indicates with which factor the leaching of nitrate must be corrected. A 
situation with very low ground water levels (GtVII*) is taken as a reference. Tbese values are, 
however, applicable to the total nitrate run off, so that translation for the subflows is difficult. 

Infiltration 
capacity 
(mmW 

0.2 
0.37-0.45 

The nitrate concentration in the quick ground water discharge may be linked to the concentration in the 
deeper soil layers (slow ground water mnoff) by means of denitrification factors. 

Maximum 
thinning of the 
ground water 
moisture per 

RAM Precipitation Runoff Module Background . 42 

12 
4 

hour 
6% / 150% 
0.8-1% 1 80% 



Input 

Model Parameters 

Quick component ground water 
discharge unpaved surface (formula 16 
or 17) 
Ammonium-N concentration quick 
component ground water discharge 
unpaved surface 
Nitrate concentration slow component 
ground water discharge unpaved surface 
Denitrification factor 
Ammonium load quick component 
ground water discharge unpaved surface 
Nitrate load quick component ground 
water discharge unpaved surface 

Qquick,, 

N I [-l 

Phosphor 

[m3/s] 

' N H ~  - N,quick,t 

Output I ' N H ~  - N,quick,t 

Significant leaching of phosphor may occur when the ground water level rises into the phosphor 
saturated zone. In general, also the phosphor fixation capacity in the shallow ground layers in The 
Netherlands is only partly used. The Ministry of VROM indicated a number of areas in The 
Netherlands, which are sensitive to P leaching. In the remaining areas' the points of departure wil1 be 
that the phosphor fixation capacity has not been used in this way, an equilibrium exists between the P- 
complex and solved P, and phosphor does not leach substantially. Areas with a utilisation degree of the 
phosphor fixation capacity of over 25% are considered phosphor saturated grounds. In these grounds 
increased P loads may be leached. The relation between P content in the quick component of ground 

[mgNi11 

k N N  

water discharge and the use degree of the phosphor fixation capacity is a point for funher investigation. 

The P concentrations are not expected to depend strongly on the precipitation flow rate, but do depend 
on the adsorptioddesorption equilibrium. The P load in the soil is in those cases so large that thinning 
does not play any meaningful part. Also to phosphor a first order equation is applicable. In addition, 
phosphor may leach, in the form of fme, suspended maner. 

Input 1 Qquick,r 

Target values surface runoff, slow and quick component of the ground water discharge 
The concentration of surface mnoff, the slow and quick component of the ground water discharge of 
unpaved surface depend mainly on soil type and land use. Three soil types are distinguished: 
- sand 
- clay 
- peat 
The next types of land use are distinguished: 
- unfertilised land 
- fertilised grassland 
- fertilised green maize fannland 
- fertilised other farmland 
Besides these categories, areas with specific land use can be distinguished such as horticulture or bulb 
farming. The impact of these types of land use in leaching of nutrients is ves. specific, due to the 
specific conditions with regret to fertilisation and water management. 

a 

Model Parameters 

Output 
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[m3/s] Quick component ground water 
discharge unpaved surface (formula 16 

'P - totul,quick, t 

'P - iora/,quick,r 

[mg PII] 

[g Pis] 

or 17) 
Phosphor concentration quick 
component ground water discharge 
unpaved surface 
Phosphor load quick component ground 
water discharge unpaved surface 



Table 7 lists the target values for the types of discharge, specified for soil type and land use. These 
values are rough estimates based on incidental measurements found in the literature. The 
concentrations of nutrients in discharges fluctuate over seasons, degree of fertilization, organic 
content etc.. It is strongly emphasized that these target values are incidental and therefore not 
representative for other areas. It is therefore strongly recommended to use measured values within the 
area of interest as much as possible. 

Table 7: Target values concentration nutrients 

a Meinardi, 1991 

b Drecht, 1986 

C Meinardi en van der Vaik, 1989 (vartgesteld voor totnal-suoomgebied) 

d Steenvaorden ct al 1993 (bij GW1 en GW11 als totaal-N) 

e Bols e l  al, 1978 (bij ondiep grondwater 2m-maaiveld) 

Target values denitrification factor 
Table 8 gives an overview of the denitrification factor for the various ground water steps 

Table 8: Overview of the denitrification factors and ground water steps (van Drecht et al., 1991) 

Ground water GLG (cm-surface GHG (cm-surface Denitrification factor 
step level) level) 

I 6 0  2 5  0.04-0.05 
11 50-80 >Z5 0.08-0.1 
I11 80- 120 25-40 0.22-0.31 
IV 80-120 40-80 2.00-0.42 
V 120-160 <25 0.15-0.5 
V1 120-160 40-80 0.22-0.48 
V11 160-220 80-140 0.73-0.83 
vII' 220-280 140-200 l 

2. Slow component ofground water discharge 
Nitrogen 
Nitrogen may also be discharged eventually through the deeper soil layers into the water course (ree 
figure 4) by means of infiltration and percolation. The slow component of ground water discharge has 
a relatively long retention time in the soil. In addition, the ground water acts as a buffer, by means of 
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which concentration differences are flattened out to a large extent. This picture is confnned by 
calculations of the nitrate concentration by means of the programme NITSOL (Hopstaken et al., 1987). 
At a depth larger than 2 m. low and constant nitrate degrees are measured. This means that a zero order 
relation wil1 suffice. 

Solved nitrogen mainly occurs in the form of nitrate and ammonium. Ammonium may be nitrificated 
int0 nitrate by bacteria in aerobic circumstances. This is denitrified into N, in anoxic circumstances 
(see intermezzo I). In most cases, the denitrification is the velocity determining step in this reaction 
chain. Only in case of peaty soil with a high organical fraction (carbon source for denitrificating 
bacteria) and anaerobic conditions in the ground water (no nitrification) the reverse is the case. In view 
of the long retention time of the water in the ground, there is a stationary situation. This results in zero 
order relations for the flow rate of the effective precipitation. 

- 

' N H 4  - A8,siow,i - Qslow,l *'NH4 - N,slow,t 

- 

' ~ 0 3  - N,slow,t Qslow,l * ' N 0 3  - N,slow,t 

Input 
Qslow, 1 

I 
Model Parameters 

' N H 4  - N,slow,l 

Slow component ground water 
discharge unpaved surface (formula 16 
or 17) 
Ammonium-N concentration slow 
component ground water discharge 
unpaved surface 
Nitrate concentration slow component 
ground water discharge unpaved 
surface 
Ammonium load slow comuonent 
ground water discharge unpaved 
surface 
Nitrate load slow component ground 
water discharge unpaved surface 

Phosphor 
In section 2.1.2.2 Reaction processes in the soil it is indicated that the adsorption/desorption of soil 
components is the most important process in the P management. Phosphor is fixed in the soil, because 
of which a steep phosphor profile comes int0 existence, which decreases along with increasing depth 
(Kroese et al, 1990). In The Netherlands the phosphor fixation capacity of the deeper soil layers is still 
hardly used. The phosphor mnoff with deep ground water is, therefore, zero and in any case constant 
with the time. 

Input 
Qslow,t 

[m3/s] Slow component ground water discharge 
unpaved surface (formula 16 OT 17) 

Model Parameters [mg PA] Phosphor concentration slow component 'P - total, slow, I 
ground water discharge unpaved surface 

Output [g PISI Phosphor load slow component ground ' P  - iotd,slow,1 water dischawe iinnaved surface 

Target values 
The concentrations of the slow component of ground water discharge are mainly determined by the 
type of soil and the land use. Sandy soil, clay soil and peaty soil are distinguished between. A further 
distinction is made by: 

Non-fertilised land; 
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Fertilised gassland; 
Fertilised green maize fannland; 
Fertilised other farmland. 

In addition, there are areas with a specific ground use, such as bulb-growing and greenhouse culture. 
The contribution by these areas to leaching of N and P is very specific due to the specific fertilisation 
and water management. In this case the user himherself wil1 have to estimate the parameters or derive 
these from measuring. 

Conclusions 
In the description of the water quality it was tried to picture the relation between the P and N loads 
discharged into the drainage system and the hydrograph. Zero order equations seem to he most suitable 
fora  empirica1 approach in a simple model. In general, this approach is motivated by means of 
arguments regarding the processes. On-line measuring data of the N and P concentrations in the sub 
flows considered are hardly known. Model-related data are often applicable to longer periods (decades, 
seasons and years). A smaller step size in which also the relation is included with the discharge, 
requires a much more detailed insight into the processes than is available at this moment. 

With regard to the target values of the concentration. the problem arises that the available data usually 
do not apply to tbe various ground water flows, on which this study is based. Therefore, the available 
data need to he translated for the subflows in this study. In addition, many data are not known. Also 
model-related values usually are not applicable directly to the subflows in this study. These values are 
often calculated in models, hut only act as interim values that are not presented in reports. In order to 
generate values for the subflows, calculations could he executed, for example by means of ANIMO. 

The smaller a step's size, the more the inaccuracy of the model results increares, because on this time 
scale the inaccuracy in the input parameters increases. This only applies to the description of the water 
quality. 

2.3.5 Seepage 
In addition to the discharges that are calculated for open water, paved surface and unpaved surface, the 
user may enter a t e m  seepage, which is defined for the total surface. 

Input Ah [ml Hydraulic head difference 
C [dayl Vertical hydraulic resistance 

Arofal [hal 
Total surface 

Model Parameters b' [-l Conversion factor units 

Output [m31s] Discharge seepage 
Qseep, r 

* The conversion factor is equal to 10000/(24*3600). 

The related water quality is detemined by a zero order equation 

- 
' N H ~ -  N,seep,t - Qseep,t * ' N H ~ -  N,seep,l 

- 

' ~ 0 3 -  N,seep,r Q.yeept,t * ' ~ 0 3 -  N,~eep,r 
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Input [m3/s] Discharge seepage (formula 24) 
Qseep, t 

Model Parameters [mg NI11 Ammonium N-concentration ' N H 4  - N,seep , t  discharge seepage 
[mg NI11 Nitrate concentration discharge ' N 0 3  - N,seep , t  

seepage 

Output 'NH4 - N , I  [g NISI 
Ammonium load discharge seepage 

' ~ 0 3 -  N , t  [g NISI 
Nitrate load discharge seepage 

Input I [m3/s] Discharge seepage I Qseent  c . . 
Model Parameters [mg P/ll Phosphor concentration discharge I ' P  - to ta~ , seep , t  

QeOn2ee 
I I 

Output I [g PISI I Phosphor load discharge seepage I SP - t o t a i  ceen~ t 

Target values 
The values for the seepage and the concentrations depend strongly on the local situation. It is therefore 
impossible to give target values. Mostly, local data are available abont the seepage and the 
concentrations. 

2.3.6 Total discharge and total load 

nput 

Wodel Parameters 
3utput 

Discharge open water surface 
(formula 2-b) 
Discharge unpaved surface (formula 
27-a) 
Discharge paved surface (formula 6- 
c) 
Surface discharge unpaved surface 
(formula 15-b) 
Quick component of ground water 
discharge unpaved surface (formula 
1601 17) 
Slow component of ground water 
discharge unpaved surface (formula 
1601 17) 
Runoff seepage (formula 24)  

Total discharge 

ïhe total of nitrate and ammonium loads in a catchment area is determined in accordance with: 
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Model Parameters 
output 

Ammonium load open water 
surface (formula 3-a) 
Nitrate load open water surface 
(formula 3-b) 
Ammonium load unpaved 
surface (formula 28-a) 
Nitrate load unpaved surface 
(formula 28-b) 
Ammonium load paved surface 
(formula 7-a) 
Nitrate load paved surface 
(formula 7-b) 
Ammonium load surface mnoff 
(formula 18-a) 
Nitrate load surface mnoff 
(formula 18-b) 
Ammonium load quick 
component ground water 
discharge unpaved surface 
(formula 20-a) 
Nitrate load quick component 
ground water discharge unpaved 
surface (formula 20-b) 
Ammonium load slow 
component ground water 
discharge unpaved surface 
(formula 22-a) 
Nitrate load slow component 
ground water discharge unpaved 
surface (formula 22-b) 
Ammonium load wash out 
seepage(formu1a 25-a) 
Niuate load wash out 
seepage(formu1a 25-b) 
Organically fixed nitrogen load 
paved surface (fomula 7-c) 
Organically fixed nitrogen load 
surface mnoff unpaved surface 
(formula 18-c) 

Total ammonium load 

Total nitrate load 

Total organically fixed nitrogen 
load 
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a In the first version of the precipitation mnoff module the term organically fixed nitrogen has nol been 
included. 

The total phosphor load is determined in accordance with: 

' P  - total, unpwed, t 

' P  - total,pwed,t 

' P  - totai,sur,t 

' P  - tot~l,quick,t 

Input 

Model Parameters 1 - 
output I S ~ - i o t a ~ . t o t a ~ . t  

'f' - rotal, open water,/ [g p!sl 

2.3.7 Relation ground water discharge and surface water level 
The ground water discharges in10 the drainage system. The discharge therefore depends on the surface 
water level. This relation can only be included when the surface water level is input from the flow 
model. This is contrary to the point of departure of a stand alone precipitation mnoff module. 

Phosphor load open water surface 
(formula 4) 

k p!sI 

k pis] 

[g pis] 

k p!sl 

k PISI 

[g p!sl 

[g p!sl 

Two options are mentioned in order to include this relation without skipping the point of depamre of a 
stand alone precipitation mnoff module: 
1. simplified calculation of the surface water level 

The surface water level is calculated in the precipitation mnoff module by a water balance for 
the drainage system. The inflow is the calculated ground water discharge, the outfiow is the 
drainage as calculated in a simplified manner. Disadvantage of this option is the separated 
calculation of the surface water level from the flow model. Because of the simplified 
calculation in the precipitation mnoff module, the calculated surface water level wil1 deviate 
from the calculated one in the flow model. 

Phosphor load unpaved surface 
(formula 29-a) 
Phosphor load paved surface 
(formula 8) 
Phosphor load surface mnoff 
(formula 19) 
Phosphor load quick component 
ground water discharge unpaved 
surface (formula 2 l )  
Phosphor load slow component 
ground water discbarge unpaved 
surface (formula 23) 
Phosphor load discharge seepage 
(formula 26) 

Total phosphor load 

2. surface water level as input 
In this option the surface water level is input in the precipitation mnoff module. This time 
series can be obtained from a flow model. By an iterative process, the relation ground water 
discharge and surface water level can be approached. 

The ground water discharge is described by a configuration of linear reservoirs (see section 2.3.4.3). 
The relation between the ground water discharge and surface water level is implicitly discounted in the 
time constant of the reservoirs. whereas a constant surface water level is assumed. The relation 
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o between the ground water discharge and surface water level becomes relevant in case of more 
fluctuating surface water levels. 

The fluctuations in surface water levels wil1 be relatively smal1 compared to the fluctuations of the 
ground water level for sloping areas. Assuming a constant surface water level wil1 be sufficient. 
However, in specific situation strong fluctuations can occur. For example with large percentages of 
paved area, so the precipitation wil1 be stored rather quickly in the surface water. Also within 
downstream polder areas, large decreases of the surface water level can occur. 

2.4 Evaluation 
With the precipitation mnoff module, a model is developed to simulate the discharge processes, both 
the hydrographs, leaching and mnoff of nutrients. 

The point of departure of the precipitation runoff module were a simple set-up for operational use, 
connection with widely used precipitation mnoff models, and creating a direct joining of a 
precipitation mnoff module &d a flow model. The technical design fits to al1 point of departure. The 
simple set-up of the technical design create a widely usable application. Using the soil moisture 

0 
reservoir and linear reservoirs, the set-up connects to widely used precipitation mnoff rnodels. By 
joining the STOWANnie stekkerdoos WATER, a direct joint is made between precipitation mnoff 
module and a flow model. 

The set-up chosen is indeed simple but it is also extensive. ï h e  user wil1 have to enter a vast amount of 
parameters before using the module. That this relatively extensive form was chosen anyway is caused 
by two aspects. On the one hand, the wish existed to make the model suitable for an extensive 
application area (with regard to type and application). On the other hand, the wish existed to descnbe 
both the water quantity and the water quality. 

In the precipitation mnoff module, pragmatic solutions were often chosen. At some points, the 
processes are not described (capillary rise, feedback with the surface water level). Depending on the 
wishes of the users, extensions may be added in a later stage. 

2.4.1 Hydrograph description 
The Precipitation Runoff Module developed is of a strongly empirica1 nature. As a result, the 
parameters in the model usually do not have a direct physical meaning. Therefore, target values for the 
model parameters have been included in this manual. In view of the complexity of the processes in 

0 
catchment areas (local variation in type of soil, slope, ground use, etc.), also the target values indicated 
wil1 cause deviations in the results. It is strongly recommended fo calibrale the modelparameters 
based on measured discharges. 

2.4.2 Description water quality 
In the theory it was concluded that the processes of leaching and mnoff of nutrients are extremely 
complex. The value of a simple concept for the description of the water quality wil1 therefore be 
restricted. Since an estimate based on fist mles and target values obtained from literature wil1 give a 
best guess, this concept wil1 be helpfull for water boards. Also due to the complexity of the processes of 
micro pollutants, a description of these solutes was excluded from RAM. RAM is therefore restricted to 
the leaching and mnoff of nutrients only. 

Point of depamre for the description of the water quality is a direct link with the hygrograph. 
Concentrations are atbibuted to the subflows, which are affected by the supply, the reaction processes 
and the discharge. These concentrations are worked out for nitrogen, phosphor and ammonium. The 
experience with this concept can be used to 
decide whether a more detailed concept is necessary or not. 
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a Similar to the hydrograph description, it is strongly recommended to calibrate the model parameters. 

2.4.3 Recommendations 
After delivery of the first version of the precipitation mnoff module, experience wil1 be acquired in 
using the module. Based on these experiences and supplementary wishes, the precipitation mnoff 
module may be extended in a later stage. 

Aspects that were addressed during the development process of the precipitation mnoff module, may 
increase the applicability of the precipitation mnoff module. Some relevant points of improvement are 
described helow. 

Ground water discharge reduction in case of high surface water levels 
In case of high surface water levels, the ground water mnoff may stagnate. In the current version of the 
precipitation mnoff module the user himmerself needs to determine when reduction occurs. The 
applicability of the precipitation mnoff module wil1 increase, if the ground water mnoff is dependent 
from the surface water level (see section 3.7). 

Refinement soil moisture reservoir 

a In the current version of the precipitation mnoff module linear relations may be entered for the 
evaponanspiration relation (formula 12) and the percolation relation (formula 13). The applicability of 
the soil moisture reservoir is increased, if the user herihimself is able to define a (non-linear) relation. 
Furthermore, the soil moisture reservoir may be improved by includmg a capillary rise relation and by 
adding a retardation term. 

Determination maximum percolation and distribution code 
In the soil moisture reservoir the maximum percolation is entered by the user (formula 13-c). Hardly 
any guidelines for these values are known in the literature. In a more extensive version, the 
determination of the maximum percolation may be worked out in further detail. This also applies to the 
distribution code for the slow and quick ground water runoff (formulas 16 and 17). 

Water quality description 
The usability of the water quality description in the precipitation runoff module wil1 have to be 
monitored critically. It is recommended that the model is tested during a prolonged period of time in 
which the model results are compared to the measuring values (calibration). From an evaluation of 
these experiences, it wil1 appear whether the differentiation within the subflows is sufficient, or that a 
further differentiation is deemed useful. Based on this evaluation the model may be adapted. 

a 
RAM Precipitation Runoff Module Background 51 



3. Getting Started 

3.1 Define a Project 
After you have started the program you can define a new project by choosing the New commando in the File menu. 

m RAM wil1 display the New Project dialog box. For configuring a project RAM needs a number of input files. These 
include: 

node file 
This file contains the nodes of the scheme. 
network file 
This file contains the network - the relations of the nodes - of the scheme 

The Node and Network file cannot be generated by RAM. They are simply ASCII files which can be made with a 
simple editor. They follow the File descriptions of DUFLOW. Refer to the chapter on File Formats (page 88) for 
more information. The setup program did install a demo Node and Network File (MARKMOD.NOD and 
MARKMOD.NET). Please enter these filenames, including their complete path, in the New Project dialog box as 
shown below. 

You can also use the File Open dialog box by pressing the button 

In fact your new project has now been defmed but because we want to use the calculation results in another program 
we check the Export File (0) checkbox and enter the pathname of the export file. During its calculation RAM will 
generate a DUFLOW compatible result file. 

Press OK and RAM wil1 display a RAM project window consisting of two panes. The left pane shows the network 
(retrieved from the Network and Node Files), the right pane wil1 show data graphs which we will see later on. 

3.2 Configure the Precipitation and Evaporation 
RAM needs a lot of input for its calculations. Among them are the precipitation and the evaporation. To enter this 
data please follow these step by step insîructions: 

a Choose the Precipitation command in the File Menu. RAM wil1 show you the Precipitation dialog box. 
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a Press the Insert After button. RAM wil1 insert îhe h e  

0 0 : o ' J : o r J  o .  000  

Repeat this 9 times 

Select the first line in the listbox. RAM wil1 jump automatically to the Value editfield 

Enter 2.5 and press the <RETURN> key. RAM wil1 automatically select the next line in the listbox and jump 
again to the Value editfield. 

Use the same approch to enter the numbers 

I 

0.5 

3 

5 

2 

o 

Because we want to start our calculation in januari 1996 instead of l995 we wil1 shift the time series. Select al1 
the lines in the listbox and choose the Shift button. RAM wil1 display the Shift values dialog box. 

Check the Forward in Time radiobunon 

Enter 365 in the Days editfield. 

Press the OK bunon. You wil1 notice RAM has shifted the time series to 1996. 

a Press OK (in the Precipimtion dialog box) 
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a RAM wil1 display the Precipitation graph in its right pane 

Repeat these steps for entering the Evaporation but make the following modifications: 

Enter 3 lines with the values 1, 0.2 and 0.8. 

Change the Date and Time edit fjelds to 

01-01-1996 0O:OO:OO 

04-01-1996 0O:OO:OO 

10-01 -1996 0O:OO:OO 

[Since RAM tries to maintain its data integrity you are forced to start changing these date values backwards] 

3.3 Configure the Nodes 
In order to calculate the mnoff and the loads of the nodes in the network RAM needs to know a lot of properties of 
these nodes. To enter this properties please follow these steps: 

0 Choose the Properties command in the File - Nodes menu. RAM wil1 show you the Node Properties dialog box. 

Since RAM needs such a lot of data RAM wil1 allow you to simultaneously enter data for a number of nodes. In 
the Nodes tn Change combobox you can choose to change: 

All nodes 

Checked nodes (only available when nodes are checked) 

individual nodes 

Select the line 1 O O in the Nodes to Change combobox. 

The amount of data per node is split in to logica1 categories. You can select the following categories in the 
categories listbox: 

Area 

Q (open surface) 

Q (paved suríace) 

Q (unpaved surface) 

Nitrate 

Phosphor 

Please refer to the chapter Background (page 2) fot a detailed description of the data. 

Select Q (unpaved surface) in the Categories listbox. RAM wil1 display at the right side of the dialog the 
unpaved surface senings. Because the unpaved surface seltings are rather extensive and because they depi 
much on the type of surface of the node RAM works with schemes. This enables you to simply reuse the 
unpaved surface settings for other nodes. . Choose the ... bunon at the right side of the dialog box. RAM wil1 display Select Unpaved Surface Scheme 
dialog box. Since there are no ichemes available we can only add a new one. 

Choose the Add button. RAM wil1 display the Unpaved Suríace Settings dialog box. 

Enter sand in the Surface Type editfield. 

Enter the desired values for the unpaved surface in the dialog. 

O 
Press the OK bunon. 
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Press the OK bunon in the Select Unpaved Surface Scheme dialog box. RAM wil1 show the values of the 
unpaved surface scheme in the ~ o d e ~ ~ r o ~ e r t i e s  dialog box. 

You can enter data for the other categories following the same strategy. In case of Ammonium, Nitrate and 
Phosphor RAM also uses schemes. These schemes are in fact time series and can be entered using dialog boxes with 
the rame appearance as the Precipitation and Evaporation dialog box. 

3.4 Configure and Start the Calculation 
Finally RAM needs to know for what period you want to calculate the results. You can specifi these settings as 
follows: 

Choose the Model Calculation Settings command in the Options menu. RAM wil1 display the Model 
Calculation Settings dialog box. 

Enter 01-01-1996 in the Start Date edit field 

Enter 01-02-1996 in the End Date edit field 

Check the Calculate Water Quality checkbox 

Press the OK button 

RAM is now ready to calculate the results. 
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1 a Choose the Update Calculation command from the Model menu. Unfortunately RAM wil1 display an extensive 
error report because it needs more data. 

I ~issing d a t e  xchcme lor nodc 1. 
Missing phmphor rshmc 108 nodc 1 .  
Na uiparcd ssheme gkcn lor node Z 
Miriina a i i o i i u n  schmc lor node Z 
~ i f &  nitrale tcheme Ier node Z. 
Missing phoipho. rchnae lor node 2. 
No uiparcd rshome gkcn lor node 3. 
Mixiing a i n o n i n  rshnie lor node 3. 
Miriing nilrale sshcme lor node 3. 
Miriing photpha rcheme lor node 3. 
No uiparcd scheme givcn lor mdc 4. 
Mifring ammonin scheme lor mdo I 
Mitting niliatc d e m e  lor node 4. 
Missing phosphoi xhcmc lor node 4~ 
No uipaved tcheme gken lor mde 5. 

You could enter al1 the required data manually as you have learned in the previous paragraphs but this is to much 
work in this introduction. It is now time to cheat and use another powerfull feature of RAM. RAM is able to reload 
settings from an old Node Settings File. Please follow these steps: 

Choose the Load Defaults command from the Edit - Nodes menu. RAM wil1 show the Load Default Node 
Properties dialog box. 

Press the Select Al1 button 

Check the Check checkbox 

Press the button and select the file DEM0.LA.M file in the Select Properties From dialog box (this file is 
installed by the RAM setup program) 

Press the OK button. 

P .B .  By reloadig settings from a file RAM wil1 overwrite the corresponding settings of the current project.] 

Choose the Update Calculation command from the Model menu to restari the calculation. RAM wil1 display a 
Calculation Progress dialog box. 

a 
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3.5 Display the Results 
After succesfully completing the calculations we are now able to display the results in the right pane of the project 
window. In this pane you can only show mnoff and load graphs of checked nodes. Suppose you want to check node 
1. You can check this node as follows: 

Make sure RAM is in zoom mode; in the Edit menu there is a checkmark before the option Zooming Tool and 
the zoombunon in the toolbar is pressed: 

p- 

ficw Model _, 

Eq 1-1 l? 
selection mode - 

l i e w  Model , 
q lm[ IT 
t.. 

zoom mode: 

Position the mouse near node 1 midden behind node 5), press the left mouse bunon and drag it. Make sure node 
l is in the rectangle which RAM draws while dragging and release the mouse bunon. 

Repeat this proces  if necesary. 

Change RAM to Selection mode via the buttonbar or the Edit menu. 

Click node l ; it wil1 be displayed in the selection color. 

[You can also check nodes in the Check Nodes dialog] 

When node 1 is selected you can display its graphs. 

Choose the Display Graphs command in the View menu. RAM wil1 display the Display Graphs dialog box. 
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Check the Show Precipitation Graph and Show Evaporation Graph checkboxes if you want to see these 
graphs. 

Check the Open Water Runoff, Paved Surface Runoff , Unpaved Snrface Runofland Total Runoff 
checkboxes for node 1. You can also click directly in the listbox. 

[RAM also offers the possibility to display results hom other files (DUFLOW compatible files and RAM 
calculation files). If you have loaded such a file, via the Import Reference Data dialog box you c m  choose them 
as source in the Source goupbox.] 

Press the O K  bunon 

RAM wil1 display the graphs 

3.6 Tips 
Use the Help funtions 

The help functions of RAM can be invoked in several ways 

using the Help menu Get general RAM help or general Windows help 

Fl  key Help about the active window or dialog wil1 be displayed. 

using the Help bunon in dialogs Displays help about the active dialog. Has the same effect as 
using the Fl key. 
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using the context help commando: The cursor changes to an arrow and question mark. Help 
about the subsequently clicked object wil1 be displayed. 

in the buttonbar 

using the SHIFT-Fl key same as for the context help bunon 

Tips lor  buttons and menu 

RAM gives a description of menu options using the statusbar at the bottom of the window. For both menu and 
buttonbar RAM wil1 show the description if you press the mouse (or keyboard for the menu) above the options. I f  
you release the mouse outside the option the option wil1 be canceled. 

RAM also gives tips by yellow balloons above the toolbar. Locate the mouse above the button, don't press the 
mouse bunon, and in a few seconds a balloon is displayed. 

Using the right menu 

In order to speed up operations for experienced users RAM supports the right mouse button in the Network window 
as wel as in the Graph window. When you press the right mouse button RAM displays a context menu containing 
the most frequently used commands. 

Zooming and Selection mode 

RAM supports two modi for the Network window. Since it is most likely for you to change these modes frequently 
RAM enables you to zoom while staying in Selection mode. 
In Selection mode the following extensions are supported: 

SHIFT key the nodes in the dragged rectangle wil1 be added to the already 
checked nodes. 

CTRL key the check status of the nodes in the dragged rectangle wil1 be 
toggled. 

SHIFT+CTRL key RAM wil1 zoom in to the dragged rectangle. The check status of the 
nodes wil1 not be altered. 

Speed up calculation 

It is possible to speed up calculation by only setting the options you really need: 

If you are interested in only a few nodes set the Total Area in the Node Properties dialog box to O for the other 
nodes. 

Use the log options sparingly; only checked nodes. 

Calculate loads only if you need them. 

Choose the time steps as large as possible. 

RAM Precipiíation Runoff Module Getting Started 59 



Making a backup of your project files. 

Please also refer to chapter 7 File Formats. If you plan to make a backup of your project data files be sure also t0 
backup at least the following files: 

file 

*.RAM 

*.LAM 

*.DAT 

* .NOD 

*.NET 

description 

RAM configuration file 

Node Settings file 

index file of the Node Settings file. 

nodes file 

network file 

when 

always 

always 

always 

optionally 

optionally 
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4. Commands 

4.1 File menu commands 
The File menu offers the following commands: 
New Creates a new set of input- and output-files la new Project). 

Open Opens an existing Project File. 

Configure f'roject Redefines the set of input- and output-files íthe Projector the Project 
File). 

Close 

Save 

Save As 

Print 

Print Preview 

Print Setup 

Page Setup 

1, 2, 3, 4 

Exit 

Closes an opened Project. 

Saves a Pro~ect File using the same file name. 

Saves a Prolect File to a specified file name. 

Prints the contents of the active prolect. 

Displays the pro~ect contents on the screen as it would appear printed. 

Selects a printer and printer connection. 

Defines the relative size of the graph, and the printed line styles 

Opens the most recently opened projects 

Exits RAM. 

4.1.1 New command 
Use this command to create a new Project in RAM. Select the files that you want to use in the File New dialog box. 

You can open an existing Project File with the Open command 

Shortcuts 

Toolbar: ril 
Keys: CTRL+N 

4.1.2 Open command 
Use this command to open an existing project file in a new window. Select the (type of) file in the File open Dialog 
Box You can open multiple projects. Use the Window menu to switch among the multiple open projects. See 
Window 1 ,2 ,  ... command. 

You can create a new project with the New command. 

Shortcuts 

Toolbar 
Keys: CTRL+O 

-~ 

RAM Precipitation Runoff Module Commands  61 



4.1.3 Configure command 
i Use this command to redefine the Project in the Configure Project dialog box. 

4.1.4 Close command 
Use this command to close the project window. RAM suggests that you save changes to your files before you close 
the project. If you close a project without saving, you lose al1 changes made since the last time you saved it. Before 
closing an untitled project, RAM displays the Save As dialog box and suggests that you name and save the *.RAM 
and *.LAM-files. 

You can also close a project window by using the Close icon on the document's window, as shown below: 

4.1.5 Save command 

0 
Use this command to save the Project(*.RAM)- and Node Senings(*.LAM)-files to its current names and 
directories. When you save a file for the fust time, RAM displays the Save As dialog box so you can name your 
files. If you want to change the name and duectoiy of an existing file before you save it, choose the Save As 
command 

Shortcuts 

Toolbar: 
Keys: CTRL+S 

4.1.6 Save As command 
file. Use this command to save and name the active Project (*.RAM) 

can name your files. 
RAM displays the 

To save files with their existing names and duectories, use the Save command. 

4.1.7 Print command 

Save As dialog box so you 

Use this command to print a document. This command presents a Print dialog box, where you may specify the range 
of pages to be printed, the number of copies, the destination printer, and other printer setup options. 

Shortcuts 

Toolbar: @J 
Keys: CTRL+P 

4.1.8 Print Preview command 
Use this command to display the active document as it would appear when printed. M e n  you choose this 
command, the main window wil1 be replaced with a print preview window in which one or w o  pages wil1 be 
displayed in their printed format. 

The print preview toolbar offers y w  options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job. 

4.1.9 Print Setup command 
Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, 
where you specify the printer and its connection. 

0 
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4.1 . l 0  Page Setup command 
Use this command to change the layout of the printed pages. RAM present8 the Page Setup dialog box 

4.1 . l  1 2, 3, 4 command 
Use the numbers and filenames listed at the bonom of the File menu to open the last four Projects you closed 
Choose the number that corresponds with the Project you want to open. 

4.1.12 Exit command 
Use this command to end your RAM session. You can also use the Close command on the application Control 
menu. RAM prompts you to save projects with unsaved changes. 

Shnrtcuts 
Mouse: Double-click the application's Control menu button 

U 
Keys: ALT+F4 

4.2 Edit menu commands 
The Edit menu offers the following commands: 
Zooming tool Zooms in on the network 

Zoom out Zooms out to rhe previous stage of zooming 

Entiie network 100% Shows the entire nehvork 

Nodes Properties Sets al1 node properties 

Check Checks the nodes 

Load Default Loads default node settings, per node, from file 

Precipitation Editr precipitation parameters 

Evaporation Editi evaporation parameters 

4.2.1 Zooming tool command 
Use the zooming tool to show p m s  of the network in more detail. After selecting the command (from the menu or 
the toolbar) the cursor wil1 change into a magnifying glass. Dragging the cursor displays a rectangle on your screen 
This rectangle represents the area that wil1 be magnified (the rectangle wil1 he blown up until it fills the network 
window). 

To end the zooming deselect the menu-item or the toolbar bunon 

Shortcuts 

Toolbar: 

4.2.2 Zoom out command 
Zooming is usually done in stages, more and more detail of the network is displayed. Zooming out Iets you retrace 
these stages. Zoom out works independent fiom the woming tool (the zooming tool needn't be selected to zoom 
out). 

To zoom out to the unzoomed state use the Entire network command 

Shortcuts 
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Toolbar: @ 
4.2.3 Entire network command 
The entire network command shows the entire network (before zooming). instead of zooming out in stages (Zoom 
out command). 

Shortcuts 

Toolbar 

4.2.4 Properties command 
Use this command to edit node properties. Afler selecting tbe command RAM displays the Node Properties dialog 
box. 

4.2.5 Check command 
Use this command to check nodes. The selection is made in the Check Nodes dialog box. 

Checked nodes are used to display graphs, in the Node Properties and Load defaults dialog boxes and for generating 
the logfile. 

Nodes can also be checked with mouse actions (see Network Window). 

4.2.6 Load Defaults command 
Use this command to load defaults, from Node Senings files, for properties. RAM shows the Load Default Node 
Properties dialog box in which the property and file selection is made. 

4.2.7 Precipitation command 
Use this command to set or modify the Precipitation time series. RAM shows the Precipitation dialog box. 

4.2.8 Evaporation command 
Use this command to set or modify the Evaporation time series. RAM shows the Evaporation dialog box. 

4.3 View menu commands 
The View menu offers the following commands: 
Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

Legend Shows or hides the Legend Window 

Display Graphs Sets display options per node 

4.3.1 Toolbar command 
Use this command to display or hide the Toolbar, which includes bunons for some of the most common commands 
in RAM, such as File Open. A check mark appears next to the menu item when the Toolbar is displayed. 

See Toolbar (page 84) for help on using the toolbar 
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4.3.2 Status Bar command 
Use this command to display or hide the Status Bar, which describes the action 10 be executed by the selected menu 
item or depressed toolhar bunon, and keyboard latch state. A check mark appears next to the menu item when the 
Status Bar is displayed. 

See Statusbar (page 85) for help on using the status bar. 

4.3.3 Legend comrnand 
Use this command to display or hide the Legend window, which describes the content5 of the Graph window. 

4.3.4 Display Graphs command 
Use this command to set display options per node, and per source and for precipitation and evaporation. Aftei 
selecting the command RAM shows the Display Graphs dialog box. 

4.4 Model menu commands 

4.4.1 Update Calculation 
Use this command to update the calculation. RAM wil1 display a calculation Progress dialog box which enables you 
to cancel the calculation. 

4.5 Options menu commands 
The Options menu offers the following commands. 
Model Calculation Settings Sets the time settings of the calculation 

Colon Graph Window Configures the colors of the graph window 

Styles and Colors Network Window Configures the colors and styles ofthe network window 

Irnpon Reference Data Irnporti external data 

4.5.1 Model Calculation Settings command 
Use this command to set the settings that govern the calculations. RAM wil1 show the Model Calculation Setting 
dialog box. 

4.5.2 Colors Graph Window command 
Use this command to change the colors in the graph window. After the selection of the command RAM wil1 show 
the Colors Graph Window dialog box. 

4.5.3 Styles and Colors Network Window command 
Use this command to customize the styles and colors of the nodes, sections and other features in the Network 
Window. After selecting the Stylesand Colors Network Window command RAM wil1 show the Styles and Colors 
dialog box. 

4.5.4 Import Reference Data 
Use this command to import data that can be compared to the calculation data generated by RAM. After selecting 
the command RAM wil1 show the Import Reference Data dialog box. 

RAM Precipitation Runoff Module Commands 65 



4.6 Window menu commands 
The Window menu offers the following commands, which enable you to arrange multiple project windows in the 
application window. 
Cascade Arranges windows in an overlapped fashion. 

Tik Horizontal Arranges windows in non-overlapped tiles. 

Tik Vertical Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of rninirnized windows. 

Window 1, 2, Activate the specified window. 

4.6.1 Cascade command 
Use this command to arrange multiple opened windows in an overlapped fashion. 

4.6.2 Tile Horizontal command 
Use this command to horizontally arrange multiple opened windows in a non-overlapped fashion 

4.6.3 Tile Vertical command 
Use this command to vertically arrange multiple opened windows in a non-overlapped fashion 

4.6.4 Arrange Icons command 
Use this command to arrange the icons for minimized windows at the bonom of the main window. If there is an 
open project window at the bottom of the main window, then some or al1 of die icons may not be visible because 
they wil1 be underneath this project window. 

4.6.5 2, ... command 
RAM displays a list of currently open project windows at the bonom of the Window menu. A check mark appears in 
front of the project name of the active window. Choose a project from this list to activate its window. 

4.7 Help menu commands 
The Help menu offers the following commands, which provide you assistance with RAM. 
Index Offers you an index to topics on which you can get help. 

Using Help Provides general instructions on using help. 

About Displays the version nurnber of RAM. 

4.7.1 Index command 
Use this command to display the opening screen of RAM Help. From the opening screen you c m  jump to several 
RAM help topics. 

Once you open Help, you can click.the Contents bunon whenever you want to return to the opening screen. 

4.7.2 Using Help command 
Ure this cornmand for insmictions about using Help. 
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4.7.3 About cornrnand 
Use this command to display the copyright notice and version number of your copy of RAM, in the About RAM 
dialog box. 

4.7.4 Context Help command 

pg 
Use the Context Help command to obtain help on some portion of RAM. When you choose the Toolbar's Context 
Help bunon, the mouse pointer wil1 change to an arrow and question mark. Then click somewhere in the RAM 
window, for example another Toolbar bunon. The Help topic wil1 be displayed for the item you clicked. 

Shortcut 

Keys: SHIFT+FI 
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5. Dialogs 

5.1 File menu related 

5.1.1 New Project or Configure Project dialog box 
Specifi the files you wish to use in the RAM-pro~ject. Al1 project data (or reference t o  data in files) can b e  stored in a . . . - 

Project File after choosing Save in the File menu. 

The following file-types are feasible: 
Node File input oniy *.NOD File that contains the position of nodes. The 

nodes are used as calculation points. 

Network File input-only *.NET The nodes are connected through a network. 
The Network File contains the network, and its 
geographical dispersion. 

Node Settings File input and output *.LAM Custorn RAM settings are stored in the Node 
Settings File 

Calculation File input and output *.CLC Calculations can be stored in a Calculation File 
(optional) (to prevent loss of data). This is useful in case 

of extended calculations. 

Export File output only *.BND The Expon File is used as an interface to 
íoptional) DUFLOW. n i e  generated data can be used in 

further calculations in DUFLOW. These files 
can also be imponed via the cornrnand Import 
Referente Data 

The file selection can be made after clicking the bunons behind the editfields. The displayed selection dialog is the 
sarne as  the File Open dialog box. 
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5.1.2 File Open dialog box 
This dialog is used by RAM t o  open f les. Because RAM uses many files you wil1 encounter this dialog box in 
several places. 

-- 

l- 

The following options allow you to specify which file to open: 

File Name Type or select the file you want to open. This listbox h t s  files with 
the extension you select i n  the List Files of Type combobox. 

List Files of Type Select the type of file you want to open (depending on the context): 
*CLC is the extension for a calculation file 
'BND is the extension for an export file 
*.LAM is the extension for aRAM node settings file 
N E T  is the extension fora  network file 
*NOD is the extension for a node file 
* R A M  is the extension for a project File 

Drives Select the drive in which RAM locates the file that you want to open. 

Directories Select the directory in which RAM locates the file that you want to 
open. 

Network ... Choose this bunon to connect 10 a nenvork location. assigning it a new - .  
drive lener. 

The following options allow you t o  specify the name and location o f  the Project File you're about to save. 

File Name Type a new name to save the Project with a different name. A 
filename can contain up to eight characters and an extension of up to 
three characters. RAM adds the extension you specify in the Save 
File As Type box ( i e .  *.RAM). 

Drives Select the drive in which you want t0 store the Project. 

Directories Select the directory in which you want to store the Project. 

Network.. Choose this bunon to connect t0 a network location, assigning it a 
new drive letter. 
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5.1.4 Print dialog box 

The following options can be chosen before the printing starts: 

Print Range Specify the pages you want to print: 

All -prints the entire document 

Pages - Prints the pages you specify 

Print Quality Choose the print quality you want 

Print to File Prints to a file on the drive you specify instead of routing it directiy 
to a printer. You store the project print commands in a file so that 
you can print from another computer fwith the same printer driver) 
that does nol have RAM installed 
When you choose Ihe OK button, RAM displays a dialog box so 
that you can type a new filename. 

Copies Type the number of copies you want to print 

Collate Copies Organizes pages when you print multiple copies. RAM prints a 
complete copy ofthe first document before it begins to print the first 
page ofthe second document. 

Printer Select a printer and a printer connection. You can also control 
default printer settings for the selected printer. See Print Setup 
dialog box 

5.1.5 Print Setup dialog box 
Select a printer and a printer connection. You can also control default printer settings for the selected printer. AI1 
options are printer specific. 

~ 

5.1.6 Page Setup dialog box 
T o  fit the graphs and its legend to a p a g e  use the Page Setup dialog box. By typing the relative size o f  the graph, 
more or less o f  the legend can be shown on the graph page. 
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Line Styles can be set in the Line Styles on BW Devices dialog box 

5.1.7 Line Styles Graphs on BW Devices dialog box 
Ali graphs are shown in color on your screen (uniess you have a monochrome display adapter). The difference 
between lines might get lost when printing on a black and white printer. The Lines Styles dialog box substitutes 
styles for colors. A iine style can be chosen for each predefined line. 

The settings can be used as defauit by clicking the checkbox "Use as Default Settings". 

5.2 Edit related dialogs 

5.2.1 Node Properties dialog box 
Modifying properties of the nodes is done in the Properties dialog box. 

First a node selection has to be made using the Nudes to Change combo box. The numbers are respectively the node 
number, the x-coordinate and the y-coordinate of the node. One separate node can be modified, al1 nodes can be 
changed at the sarne time, or the properties of a selection of nodes (see Check Nodes dialog box) can be changed. 
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The following categories of properties are modifiable, the properties (and the dialog) change when you select a new 

category: 
categoiy properties 

Area Total area Precipitation collection area [ha] 

%Open Percentage of the total area that 
consists of surface water [-l 

% Paved Percentage consisting of ( fa t  
spouting) paved surface [-] 

% Unpaved Percentage of the area used as 
farmland. (the precipitation is flowing 
away slowly). [-l 

% Sewer Sewer, used in the calculations. [-] 

Open surface k Time constant, reservoir separated 
sewer system [day] 

f Crop factor Makkink [-l 

Paved surface ks Time constant, reservoir separated 
sewer system [day] 

kp Time constant reservoir paved surface 
[dayl 

Note: For the crop factor Makkink (0 the open surface value is also 
used for paved surface. 

Unpaved surface Bmax Maximum storage in surface 
depressions [mm] 

Surface iype Surface Type and its contents are set 
in the Select Unpaved Surface Scheme 
dialog box 

Seepage .- C vertical hydraulic resistance of 
covering layer [day] 

DH hydraulic head difference covering 
layer and water transporting package 
[ml 
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Ammonium 

A Nitrate 

Phosphor 

Concentration schemes for: 
Open Water 
Paved Surface 
Unpaved Surface (Open) 
Unpaved Surface (Slow) 
Unpaved Surface (Fat)  
Seepage 

Concentration schemes are selected in the Select 
Concentration Scheme dialog box 

Concenttation schemes for: 
Open Water 
Paved Surface 
Unpaved Surface (Open) 
Unpaved Surface (Slow) 
Unpaved Surface (Fa t )  
Seepage 

Concentration schemes are selected in the Select 
Concentration Scheme dialog box 

N Nitrate concentration 

Concentration schemes for: 
Open Water 
Paved Surface 
Unpaved Surface (Open) 
Unpaved Surface (Slow) 
Unpaved Surïace (Fast) 
Seepage 

Concentration schemes are selected in the Select 
Concentration Scheme dialog box 

5.2.2 Select Unpaved Surface Scheme dialog box 
Properties descrihing the unpaved surface are grouped in a Unpaved Surface scheme. The schemes facilitate the use 
of  predefmed data and the use of schemes íÏom other projects Al1 schemes availahle are shown in the listbox. 

, , ~ ~  ~ 

Add, Modify Schemes can be added or modified by using the appropriate button. 
Modify wil1 show the Unpaved Surface Settings dialog box with the 
schemes values. Add wil1 show the Same dialog with the default 
values. 

Delete Deletes the selected scheme 

COPY Copies the selected scheme in the listbox to make small alterations 
without changíng the original. The copied scheme h a  the same 
name and an added number. 
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5.2.3 Unpaved Surface Settings dialog box 
-P 

SwI- T m  lm m 
Gonsal- 

-1 

Fill out the unpaved surface scheme, using the  following parameters: 

Heading Properties Explanation 

Surface Type Scheme name 

General Atlributes Imax Infikration capacity [mmlday] 

f Cropfactor Makkink [-] 

F0 moisture storage at pF = O [mm] 

F2 moisture storage at pF = 2 [mm] 

F42 moisture storage at pF = 4.2 [mm] 

Ppercmax Percolaiion to saturated zone between pF = O en pF = 

2 (maximum) [rnmiday] 

Ksurface Time constant reservoir unpaved surface [day] 

Kfast Time constant Sast groundwater discharge [dayl 

Kslow Time constant slow groundwaier discharge [day] 

Disiribution formula fast and slow groundwatei 
discharge [-] 

Scenario Select the Nash-cascade or the Krayenhoff- vd Leur scenario and the 
number of reservoirs to represent the discharge. 

5.2.4 Select Concentration Scherne dialog box 

Properties describing the concentration are grouped in a Concentration scheme. All schemer available are shown in 
the listbox. 
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Add, Modify Schemes can be added or modiiied by using the appropriate bunon. 
Modify wil1 show the Modify Concentration Scheme dialog box with the 
schemes values. Add wil1 show the same dialog without values. 

C ~ P Y  Copies the selected schemer in the listbox to make small alterations 
without changing the original. The copied scheme hm the same name and 
an added number. 

Delete Deletes thr relected scheme 

5.2.5 Modify Concentration Scheme dialog box 
The concentration scheme is in fact a time series scheme. Per date and time a specific value can be given. This 
dialog box is also used to modify the precipitation and evaporation time series. The units used in the various dialogs 
are: 

dialog unit 

precipitation mmlday 

evaporation mmlday 

Ammonium mg NI1 

Nitrate mg Nll 

Phosphor m u l  

There is however also a difference in interpretation of the values by RAM. In a concentration scheme RAM 
supposes a lineair relation between two given time steps. For the precipitation and evaporation the given values are 
interpreted as the values "up until now". 

for example if entered in dialog: 

time value 

l :o0 l O0 

3:OO 300 

The concentration at 2:00 is 200, the precipitation at 2:00 is 300. 

A time series can be equidistant (al1 values one timestep apart), or non-equidistant (the time between values differs). 
When switching from non-equidistant to equidistant the date and time of the value is changed to fit this equidistant 

The time series options can be set in the Time Series Settings dialog box, after clicking the Modify button. 
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a Modifyimg the concentration values or the time they occur is done using the following commands: 

Insert before Inserts a new value based on the stepsize before the 
highlighted line in the listbox. 

Insert after Inserts a new value based on the stepsize after the 
highlighted line in the listbox. 

Shift Shifts the highlighted lines in the listbox, using the Shift 
Values dialog box. 

In a equidistant time series the Shift values option can only 
be used if al1 values are selected. The series must remain 
complete, i.e. there must be a value for every time step. 
Shifting values to another date, and thereby breaking the 
time chain is not allowed. 

Remove Removes the highlighted lines from the text box. 

Select All Selects al1 lines in the listbox so that they can be 
manipulated together. 

Open ending The concentration scheme covers a period. There is also a 
calculation period (this is set in the Model Calculations 
Settings dialog box). Open ending completes a 
concentration scheme (with the last value of the scheme) to 
fit a concentration scheme to the length of a (longer) 
calculation scheme. 

Import Enables you to import a time series file saving you the 
trouble of entering this data manually. 

5.2.6 Modify Time Series Settings dialog box 
The Modify Time Series dialog box enables you t o  change the properties of a time series. RAM supports both 
equidistant and non-equidistant time series. 
Whenever you change these settings and press OK R A M  wil1 ask you to  c o n f m  the conversion. 

5.2.7 Shift Values dialog box 
T o  shift an existing value to  a new date, use this dialog. Choose whether the value has to  go forward or backward in 
time, and specify the day, h o u ,  minutes and seconds of  the shift. 
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5.2.8 Check Nodes dialog box 
The Check nodes dialog box allows you to speci@ the checked nodes. Checked nodes are used in graphs, logfiles 
and to import defauls. Checking of nodes c m  also be done by clicking the nodes in the network window. 

J 
All nodes are listed, the checkbox before each node tells you whether the node is checked. The state of a node can 
be changed by directly clicking the nodes checkbox in the listbox. 

The Select Al1 button makes it possible to make a choice for al1 nodes, by using the Ctrl or Shift button or by 
dragging the mouse other multiple selection c m  be made. The Check checkbox shows the state of the selected 
nodes: 

checked means al1 selected nodes are checked 

gray means that some of the selected nodes are checked 

unchecked means that none of the selected nodes are checked 

You can also use the Check checkbox to change the state of the selected nodes 

5.2.9 Load Default Node Properties dialog box 
Instead of filling out al1 node properties, the properties c m  be loaded from an existing file. A set of defaults can be 
loaded separately for each group of properties. Some of the properties which can be reloaded are not directly related 
to nodes. If they are their description in the Reload the Following Properties listbox is prefixed by "Node - ". 

First you have to specify for which nodes the defaults are to be reloaded, for al1 nodes or for the checked nodes (see 
Checked Nodes dialog box and network window). 

RAM Precipitation RunoWModule Dialogs 77 



Then you have to specify which sets of properties have to be reloaded. All groups are listed, the checkbox before 
each property group tells you whether the properîy is to be reloaded. The state of a property can be changed by 
directly clicking the checkbox in the listbox. The Select All button makes it possible to make a choice for al1 
properties, by using the Ctrl or Shift bunon or by dragging tbe mouse other multiple selection can be made. The 
Check checkhox shows the state of the selected properties: 

checked means al1 groups are checked 

gray means that some of the groups are checked 

unchecked shows that none of the groups is checked. 

You can also use the Check checkbox to change the state of the selected properties. 

Finally you have to speciS the file from which the defaults are to be reloaded. Type the path and the filename. To 
search the file, use the file open bunon hehind the text box, you can choose the file in the Select Properties From 
dialog box. 

5.2.10 Precipitation dialog box 
The precipitation scheme is in fact a time series scheme. ïherefore RAM uses a variation of the Modi@ 
Concentration Scheme dialog box to modify the precipitation (see page 75) .  

5.2.1 1 Evaporation dialog box 
The evaporation scheme is in fact a time series scheme. Therefore RAM uses a variation of the Modi@ 
Concentration Scheme dialog box to modify the precipitation (see page 75) .  

5.3 View related dialogs 

5.3.1 Display Graphs dialog box 
Tbe Display Graphs dialog box makes it possible to defme what is displayed in tbe graph window. 

Choices that can be made are: 
Show Precipitation Shows the precipitation time series in the graph 

Show Evaporation Shows the precipitation time series in the graph 

Source The source of the graph is the project (This document) or 
other sources which are availabie after the selection of 
Import Reference data. The imported data cm be 
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displayed, together with the data of 'This document' 

Node5 to Change Select in the combobox ifAll nodes or only checked 
nodes are to be displayed in the adjoining listbox. In this 
listbox RAM shows which graphs per node are to be 
displayed in the graph window. 
The state of a node can be changed by clicking in the 
listbox or by using the checkboxes in the Show Graphs 
groupbox. 

The Select Al1 button makes it possible to make a choice 
for al1 nodes, by using the Ctrl or Shift button or by 
dragging the mouse other multiple selection can be made. 
The graph selections apply to al1 the selected nodes. 

Show Graphs Use Show Graphs to select of the selected nodes in the 
Nodes to Change listbox, the kind of graph to show. 

The pictures represent: 

k?i Open Water Runoff 

4 Paved Surface Runoff 

Q! Unpaved Surface Runoff 

11 Seepage Runoff 

I Total Runoff 

The graphs, per node, are shown only when the node is checked. T o  check the node use the  Check Nodes dialog 
box, o r  ure the mouse (see Network Window). 

5.4 Options related dialogs 

5.4.1 Model Calculation Settings dialog box 

1 r n-&- lodL W . L O G  [xzq l 
l -. _ - _ 1 

The calculation settings are subject t o  the  following conditions: 

Period Stan Set the start date and time for the calculation 

End Set the end date and time for the calculation 

Time Step size, Calculation Set the calculation time step. 

Time Step size, Output Set the output time step, the output time step must 
be a multipic of thc calculation time step. 

Options Calculate Water Quality RAM always calculates the precipitation runoff, 
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status 

an additional choice is calculating Ihe loads or 
water quality of Ammonium, Nitrate and 
Phosphor). 

Generate Logfile RAM.LOG The steps in the calculation can be stored in a 
RAM.LOG file for calculation checks. 

Options This option enables you to specify the options 
used for generating the logfile. RAM wil1 display 
the Options Logfile dialog box. 

Shows a status windou, which displayes the 
consequences of the current settings.. 

The cunent scülngs will msuh in: 

9 tlme steps lor calculaiion 
[start = 01-01-1995 00:OO:OO; 
end = 1 Ml-l995 00:00:00] 

snd 9 Umtstcps for output 
[stafl 01-01-1995 00:00:00; 
end = 10-01-1995 00:00:001. 

5.4.2 Options Logfile dialog box 
You can select the data that is to be  included in the logfile in the Options Logfile dialog box 

The possible options are: 

Checked nodes Include data on checked nodes only. This options is preferred 
because it reduces the size of the logfile significantly. 

Open water 

Paved sutiace 

Unpaved sutiace (without 
reservoirs) 

Unpaved sutiace (with 
reservoirs) 

Seepage 

Sum 

Include data conceming open water. 

Include data conceming paved sutiace. 

Include data conceming unpaved surface without reservoirs. 

Include data conceming unpaved surface with reservoirs. 

Include data concerning seepage. 

Include the sum of al1 rutiaces. 

5.4.3 Colors Graph Window dialog box 
The color of the lines in the graph window can be  customized, using the Colors Graph Window dialog box 
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" W  

The possible options are: 

Graphs A color can he selected for each line in the graph. The lines are 
listed in the gtaphs list box. 
To select a color click a colorbox that lies on the same line as 
the line number. An example for the chosen line is shown in the 
Example groupbox.. 

Background Select the background color for the gtaph diaiog box. 

Example Shows the selected line color for the active line in the Graphs 
listbox. 

Use as Default Settings Instmcts RAM to use the current settings as the default settings. 

5.4.4 Styles and Colors dialog box 
The way in which the network is displayed can be influenced by using the Styles and Colors dialog box. 
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The  par& of the network that can b e  customized are  shown in the listbox. The  features that can be  customized 
change after selecting a part o f  the  network in the  listbox. 

The  features per  network part that can b e  changed are: 

Network part Feature 

Background Background color 

Kode Sire 

Foreground color 

Background color 

Text color 

Show Numbers 

Checked Ìiode Foreground color 

Background coloi 

Text coior 

Section Line color 

Text color 

Text background color 

Show Numbers 

Symbol 

Line color 

Fill color 

Explanation 

Changes the background color of the Network 
window. 

Sets the size of the node representation 

Sets the color of the border of the node- 
representation 

Sets the fill color of the node-representation. 

Sets the color of the text in the node (is shown 
when Show Numbers is selected). 

Shows the numbers in the node representation. 
This options also applies to the checked nodes. 

Sets the color of the border of the checked nodes, 
so they c m  be distinguished frorn the unchecked 
nodes. 

Sets the fill color of the checked nodes, so they 
can he distinguished from the unchecked nodes. 

Sets the text color of the checked nodes, so they 
c m  be distinguished from the unchecked nodes. 
The Text is shown when the option Show 
Nurnbers, belonging to the Node settings, is set. 

Sets the color of the section that connects the 
nodes. 

Sets the text color of the text belonging to the 
section that connects the nodes. 
The text is shown when Show Number is set. 

Sets the color of a box around the section text (to 
highlight it agqinst the background). 
The text is shown when Show Nurnbers 
checkbox is set. 

Shows the numbers belonging to the section that 
connects the nodes. 

Select the syrnbol for stmcts. A met is a 
connection between nodes that consist of a 
hydraulic work, to differentiate it frorn anormal 
connection a part of a flow. 

Sets the Iine color for a stmct 

Sets the fill color of a stmct 

5.4.5 Import Reference Data dialog box 
RAM gives you the opportunity to compare  the calculations you m a k e  wi 
calculations o r  í rom calculations made in DUFLOW. 

th referente data, k o m  previous 
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The comparison data have to be stored in a *.CLC-file (a RAM calculation file) or  a *. BND-file (a DUFLOW file). 

Add Add a referente data file, afier clicking the button an File Open 
dialog is displayed. 

Modify Select a referente data file (from thc File Open dialog box) 
instead of the highlighted file in the listbox. 

Remove Remove the highlighted referente data file from the importcd 
reference data list. 

5.5 Help related dialogs 

5.5.1 About RAM dialog box 
The About RAM dialog box contains the application name and logo, the RAM version number the copyright 
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6. Features 

6.1 Toolbar 

The  toolhar is displayed across the  top o f  the  application window, below the  menu bar.  T h e  toolbar provides quick 
mouse access to  many  options of RAM, 

To hide o r  display the  Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Create a new projeci 

Open an exisiing project. RAM dispiays ihe Open dialog box, in which 
you c m  locate and open ihe desired file. 

Save the active project wiih its current name. If you have nol named the 
project, RAM dispiays the Save As dialog box. 

Print the actlve document 

Zooming tool  Cse the zooming tool 10 show parts of the network in 
more detail. Afier seleciing the command (from the menu or the toolbar) 
the cursor wil1 change into a magnifying g l a s  Dragging the cursor 
displays a rectangle on your screen. This rectangle represents the area 
that wil1 be magnified (the rectangle wil1 be blown up until it fills the 
network window). 

Zoom out. Zooming is usually done in stages, more and more detail of 
the network is shown. Zooming out Iets you retrace these stages. Zoom 
out works independent from the zooming tool (the zooming tool needn't 
be selected to zoom out). 

To zoom out to the unzoomed state use the Entire network command 

Entire Network. The entire network command shows the entire network 
(before zooming). instead of zooming out in stages (Zoom out 
command). 

Calculaie 

Cascade 

Tile Horizontally 

About RAM. Shows the About RAM dialog box 

Stan Help tool, the helpfile wil1 be started autornatically afier a carnmand 
is clicked. The description of the chosen topic is shown. 
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6.2 Status Bar 

The status bar is displayed at the bottom of the RAM window. To display or hide the status bar, use the Staîus Bar 
command in the View menu. 

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. 
This area similarly shows messages tbat describe the actions of toolbar buttons as you depress them, before releasing 
them. If after viewing the description of the toolbar bunon command you wisb not to execute the command, then 
release the mouse button while the pointer is off the toolbar button. 

The right areas of the status bar indicate which of the following keys are latched down: 
Indicator Description 

CAP The Caps Lock key is latched down. 

NUM The Num Lock key is latched down. 

SCRL The Scroll Lock key is latched down. 

6.3 Network Window 
The network window shows the schematization of wateways. The schematization is built using the following 
components: 
Node Nodes represent measuring- or calculation points, they 

comprise information of the surrounding sections and stmcU. 

Section Watenvay that connects nodes 

Stmct Hydraulic work as connection between nodes 

Zoorning and selection 
You can zoom in to the network or check nodes using the mouse. The network window supports two modi, selection 
mode and zoom mode. You can change between these modes with the Zooming Tool command in the edit menu or 
with the toolbar. 
In zoornrnode you can zoom in to the dragged rectangle (press the left mouse bunon, track a rectangle and release 
the button). 
In selection mode RAM supporis several extentions. It is even possibly to zoom while in selection mode. 

o In Selection mode tbe following extentions are supported: 

SHIFT key the nodes in the dragged rectangle wil1 be added to 
the already checked nodes. 

CTRL key the check status of the nodes in the dragged rectangle 
wil1 be toggled. 

SHIFT+CTRL key RAM wil1 zoom in to the dragged rectangle. The 
check status of the nodes wil1 not be altered. 

The presentation of the contents of the network window is set in the Styles and Colors dialog box. 

A shortcut to the cornmands that influence the contents of the Network Window is provided. Clicking the right- 
mousebutîon displays a shortcut menu to the dialogs connected to the commands: 
Check Checks or unchecks nodes. 

Properties Modifies the propenies of the nodes 

Styles and Colors Sets styles and colors of thi: network window 

Precipitation Enters precipitation data 

o Evaporation Enters evaporation data 
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The Network Window shares room with the Graph window (they share the workspace of a project window). To 
make more room for the Network Window use the Splitter. 

6.4 Graph Window 
The Graph window optionally shows the calculated mnoff and loads per node and the precipitation and evaporation 

A shortcut to the commands that influence the contents of the Graph Window is provided. Clicking the right- 
mousebunon displays a shortcut menu to the dialogs comected to the commands: 
Display Sets the graphs which wil1 be displayed. RAM wil1 

show the Display Graphs dialog box 

Colors Sets the colors of the graphs 

Legend Shows ar hide the Legend window 

The Graph Window shares room with the Network window (they share the workspace of a project window). To 
make more room for the Graph Window use the Splitter. 

6.5 Splitter 
The project window is splitted into panes (the network window and the graph window) 

The space relation between the to panes is influenced by the Splitter. This is the vertical har between the two pats.  
Moving the mouse above the bar wil1 change the mouse pointer, into a splitter. The bar is moved by dragging the 
spliner mouse. 

6.6 Legend Window 
The Legend Widows  distinguishes al1 lines in the Graph Widow,  by giving the nodenumber and the explanation 
of the contents. 

The Legend Wmdow is displayed after selecting the Legend command in the View menu, or in the right mouse 
button menu in the graph window. 
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p i i a t i i  ~. .. 
aa(im 
O p a  waísi IQ Iruioffl. Uik calcila<ionl 
Parsd a l a c e  10 [rvnfl l .  thix cakulation] 
Unpav~d xuilace IQ Iiuiolll. Uur <alcUationl 
Scspagc [Q Iiuiolfl. Ih i i  calarlalion1 
Tolal IQ [ i m l l l .  Ihir calculahnl 
Open walm IQ I iundO.  C:\ONTWlKWPJIWEMO\lDAG.CLCl 
P a n d  w i l a a  10 [iunoHl. C:\ONlWIK\fùiMU)EYO\1DAG.CLCI 
Unpaed zurlace IQ Irrnolll. C:\ONTWIKWAMWEMO\IOAG.CLCI 
S c e p e  10 [runolll. ~\ONTWIK\RAM\DEMO\lOffi .CLC] 
Tolal 19 1 r ~ f I I .  C : \ONTWKWWEYO\ lDAG.UCl  

6.9 Error and Warning Log Window 
RAM displays the Error and Waming Log window when it detects errors during a time consurning p r o c e s  This 
might occur at two points: 

while starting a calculation RAM checks the input data. If it finds any errors it displays the Error and Waming 
Log dialog box. 

while importing reference data RAM checks if it can match the importcd data to !he active project 

I No lainlal1 i s  aailablc IM thc a d  o1 Ihc cakuldon 
No evamration ir aailablc Io i  Ihe *tal o1 Ik calcuhtion F 

I No e&poiatim k availablc lor Ihc a d  á the calculaíion 
No uipavcd rcheme g k m  lor mdc 1 
No uipared =hen gkcn lo i  mde 2. 
No uiparcd u;h= gkcn lor mdc 3. 
No w a e d  f s h n r  gkcn lar mde 4. 

I No -red xch- inen  loi mde 5 
NO u p s v s d  iehere qnen lot node 6 
No -red xchcae qnm Ion mdc 7 

'1 1 

The following commands are available 
Close Close the Error and Waming Log windou 

Print Print the contents of the the Error and Waming Log 
window RAM wil1 first display the Print dialog box. 

RAM Preclpitation Runoff Module Features 87 



7. File Formats 

7.1 BND 
Duflow Boundary Conditions files contain the mnoff and the loads of the calculation. They are typically used by 

a RAM to import reference data or to export data. For a complete description of this file format see the Duflow 2.0 
manual, Appendix E. The following examples explain the file format. Comment lines start with an asterisk (*). 

example 1 ,  a non equidistant time series and a constant time series 

C ' l fLnW satz file :C:'\PAY\Pm?.atlD 
rlow Elund. rond./struct crrl. program verslor.: 2.03 

*234567~5t12315679501234567890123456789012345678901234567850~2345€ 

'i 9 
' l i=zun' i ff  timestep : 0-->non equidistant noae " ' m e i  

950101 0 1.C000 
* date time value 

950101 2 2.0000 
950105 3 1.5000 
950108 4 2.5000 
950109 5 2.0000 
950121 1030 4.0000 

Q 
*Q=runof f no timestep -> constant 
P 2.5000 

14 
node number 

example 2, equidistant times series for mnoff and loads 

* DUFLOW data f i l e  C:\DPITWIY\P-sM??EST.BI1L. 
* File genorated by P314 appllcatirin vorsion 1.03. 
'234567890123456785C1234567890123456785012345678301234567890123456 

Q 0100 550101 0000 1 
*Q=runoff timestep node number 

date t ~ m e  
0.0144 0.0222 0.0268 0.0325 0.0388 6.0444 
0.0497 0.0545 0.0558 0.0646 0.0631 0.0735 
0.0777 0.0817 0.0855 C.O~$Z c.092a 0 . 0 5 ~  
0.0994 0.1025 0.1055 0.1084 0.1112 0.1138 
0.1164 
v a i u e s ,  max 6 per I;ne 

L 0100 55Cl0l 0100 nh4 1 
'L=load t ~ m e s t e p  concentration 

date time node n w b e r  
'the conbinatlon L acd concen?ratron determrne the meaning of L 

0.0144 0.0222 0.0265 0.0331 0.0390 0.0447 
0.0501 0.0554 3.0505 0.C654 0.0701 C.0746 
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7.2 CLC 
Calculation files are used are used by RAM to store calculation results. By default these results are stored in a 
temporay file that is deleted automatically on closing the project. However in case of large time consuming 
calculations it can be usefull to store the results so RAM can show them later on. You can force RAM to keep the 
calculation results in the Configure Project dialog box. The format of this file is private to RAM. 

See LAM files. 

e 
7.4 LAM 
The LAM files are called the Node Settings files. These files contain the user settings of a document. The format of 
this file is private to RAM. This file wil1 be generated by RAM ifyou save the project. In order to address the 
contents of the LAM file RAM also generates an index file (*.DAT). 

Make sure when you backup your project data also to backup the corresponding *.DAT file. 

7.5 LOG 
In the logfile RAM can trace i s  calculations. The logfile generated by RAM is always called RAM.LOG. If you 
want to compare logfiles you wil1 have to rename them yourself because RAM wil1 ovenvrite old logfiles without a 
warning. The logfile is an ASCII text file. The following is an example of a logfile. Since the format of the logfile is 
trivia1 it is not explained here. Please refer to the chapter Background (page 2). 

e ?.AM l o g f i l e :  c r o a t e d  15-05-1555 03:26:18 
Model settings Start Ol -S I - IS95  00:00:00: End 01-02-1995 03:03:0  
C t e p s ~ ~ e s :  c a l c u l a t r o n  28800. output 28800 

S t a r t  c a l c u l a t m g  4 7  nodes: 

Open water 
t = 1.000000, f = 1.000000 
l i l e d  ammonium srheme m k l e i  
Vsed nitrate scneme Nitkloi 
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7.6 NET 
The network file contains a description of the network. The network file is an ASCII text file which is human 
readable. You can change these tiles manually or generate them using a dedicated program RAM cannot generate 
these files for itself. 

The format of these file is the DUFLOW version 2.0 file format for Network files. The following example explains 
the file format. Comment lines stari widi an asterisk (*). 

- 11eti iork example: s e d  by Stiles and  Color d:alog 
- 2 3 4 5 E 7 8 5 0 1 2 3 4 5 6 7 8 5 G 1 2 3 4 5 6 7 ~ 9 0 : 2 3 i 5 6 7 B 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 ~ ~ ~ 1 2 3 4 5 6  
SECT 1 1 1 4 7100 58.68 56.86 45.0 45.0 
SECT 2 2 4 2 7130 56.86 55.03 45.0 45.0 
SEC? 3 3 i 3 5000 53.68 53.54 45.0 45.0 
SECT 4 4 i 6 i900 53.04 52.31 45.0 45.0 
SEC? i 4 t 7 5900 53.04 52.31 45.0 45.0 

se~tionname values  ignared t y  P 4 M  
secticn r.mber 

begin z l d e  niimber 
end node number 

301 STRU ? 5 0 55.03 120.03 99.00 

Al1 other data in DUFLOW network files is ignored by RAM. 

7.7 NOD 
The node file contains the nodes of the network. The node file is an ASCII text file which is human readable. You 
can change these files manually or generate them using a dedicated program. RAM cannot generate these files for 
itself. 

The format of these file is the DUFLOW version 2.0 file format for Node files. The following example explains the 
file format. Comment lines start with an asterisk (*). 

+ lwdes example; i;sed by Styles and Colar dlalog 
* 2 3 4 5 6 7 8 ~ 0 1 2 3 4 5 6 7 3 9 0 1 2 3 4 5 6 7 8 3 C 1 2 3 4 5 € 7 8 9 0 1 2 ~ 4 5 € 7 8 9 0 ~ 2 3 4 5 ~ 7 @ 9 9 1 2 3 4 5 6  

1 0 200 OE+OO 1.00 

3 
4 
5 
6 
7 
node 

All other data in DUFLOW node files is ignored by RAM. 

7.8 RAM 
RAM files are project files which contain information about the files used by the RAM project. The project file is an 
ASCII text file which is human readable. Although you can manually change these files it is not recommended. The 
format of these file is as follows: 

tidentification, 
NODES:<ThB>rpath of nodes file (NGD)> 
NETW0PE:~ThBxpath of networt file !NETI> 
RAM_NODES:<TAB><P~~~ O :  P m  setiinqs file [LM) ;  

a KEEP P.ESUL::"rRB>[O is FLLSE;: is TPUEI 
PESULT~ThBxpatn of result f11e !CLC)> 
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GENEW.TE E%POP.T:<TAB>[O is F A L S E ; l  i5 TP,CEI 
E % P O R T < T A B x p a t h  of Pxport f i l e  i a m i >  

example of RAM project file: 

#@E>J4#@STUUP 

!IODES: C :  \DEMG\bfA?.YN'ID.NOD 

!:ETWORK: C :  \DEMO\MF.RYM3D.NET 

P>h-NODES : C :  \DEMC\DEHC. LAM 

KEEP RECULT: '1 

PESULT:  c :  \ C E ! I l j  SEMO. CLC 

GEIIEPJ.TE E ï P r l P T :  5 

EXPORT: C:\DEMO\DEMO.BND 

7.9 TSS 
TSS files contain simple Time Series. The format of these files is ASCII text format. They have a very simple syntax 
and can be used to import time series int0 RAM (see the Modify Concentration Scheme dialog box). RAM assumes 
the time series in these files to be non equidistant. The syntax of these files is: 

date<TAB>time<AB>value 

with date in die format dd-mm-yy or dd-mm-yyyy and time in the format hh:mm:ss 

example of an TSS file: 

1-1-55 O : O O : 1 6  1 

S-i-55 1:00:16 5 

3-1-95 S:C4:16 3 

4-1-95 2:0G:16 4 

4:OG:lC 5 - 1 - 9 5  

6-1-55 5:03:16 E 
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Appendix I : Crop Factor Evaporation 



Appendix I1 : Staring Series 

P, - --, n o g  



Appendix I11 : Translation Definitions Dutch - English 

Hydrological cycle 
Afvoer 

Afvoerbare neerslag 

Afwateringsstelsel 

Bergingscapaciteit van de onverzadigde zone 

Capillaire opstijging 

Capillaire zoom 

Depressieberging 

Drain 

Drainage-afvoer 

Evaporatie 

Evapotranspiratie 

Grondafvoer 

Grondwaterstand 

Grondwaterstandsdiepte 

Hydrologische kringloop 

Infiltratie 

Infiltratiecapaciteit 

Interceptie 

Kwel 

Neerslag 

Neerslagintensiteit 

Neerslagoverschot 

Netto neerslag 

Onverzadigde zone 

Ontwatering 

Oppervlakte-afvoer 

Percolatie 

SchQnspiegel 

Schijnspiegelafvoer 

Specifieke afvoer 

Stroomgebied 

Transpiratie 

Veldcapaciteit 

Venuekingspunt 

Verzadigde zone 

Waterbalans 

Wegzijging 

Wortelzone 

discharge 

effective precipitation 

drainage system 

storage capacity of the unsaturated zone 

Upward capillary migration lcapillary rise 

capillary fringe 

Storage in surface depressions 

drain pipe 

drainage 

evaporation 

evapotranspiration 

ground water discharge 

ground water level 

depth of the groundwater level 

hydrologic cycle 

infiltration 

infiltration capacity 

interception 

seepage 1 exfilmtion 

precipitation 

precipitation intensity 

precipitation 

precipitation excess 

unsaturated zone 

drainage 

surface mnoff 

percolation 

perched water table l apparent water table 

interíiow 

specific discharge 

catchment area 

transpiration 

field capacity 

wilting point 

zone of saturation 

water balance 

downward seepage 

root zone 



a Water quality 

Adsorptie 

Afspoeling 

Denitrificatie 

Desorptie 

Droge depositie 

Fosforbindend vermogen (FVB) 

Immobilisatie 

Mineralisatie 

Natte depositie 

Nitrificatie 

Omzettingsprocessen 

Uitspoeling 

adsorption 

ninoff 

deniirification 

desorption 

dry deposition 

phosphoms fixation capacity 

fixation 1 irnmobilization 

mineralization 

wet deposition 

nitsification 

reaction processes 

leaching 

volatilization 



Appendix IV : Installation Procedure 

To install RAM 
1 Insert the RAM program disk into your computer. 
2 In Program Manager, choose Run from the file menu, then type A:\SETUP (your d r i e  lener 

may be different) and click OK. 
3 Complete the installation by following the instructions of the Setup program. 

4 Start RAM by double clicking the . 

files 
The installation procedure wil1 install the following files: 

location 
RAM directory 

Windows system directory 
(e.g. C:\WINDOWS\SYSTEM) 

file 
RAM.EXE 
RAM.HLP 
RAMSTS.BMF 
RAMSTS.DAT 
NETWORKCFG 
NODESCFG 
DEMO.DAT 
DEMO.LAM 
TESTJE.DAT 
TESTELAM 
TESTJE.NET 
TESTJE.NOD 
MARKMOD.NET 
MARKMOD.NET 
CTL3D.DLL 


